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1 Ubersicht der Bedienelemente
und Anschliisse

1 Status-LEDs:

POWER Betriebsanzeige
SIGNALA  Signal A nach Gain-Regler
SIGNALB  Signal B nach Gain-Regler
LIMITER Pegelbegrenzung aktiv
PROTECT Schutzschaltung aktiv

2 Taste MENU zur Auswahl eines Menipunk-
tes und zur Bestatigung einer Eingabe

3 Taste ESC zum Verlassen des Menis und
zum Abbruch einer Funktion

4 LC-Display

5 Drehknopf MASTER VOLUME fir die Laut-
starke von Eingangskanal A (Gain-Regler)

6 Drehknopf SELECT/ENTER fur die Laut-
starke von Eingangskanal B (Gain-Regler)
und zur Preset-Auswahl und Wertédnderung
im Menu

7 Status-LEDs LINK/ACT fir den Ethernet-An-
schluss (Verbindungs- und Aktivitatsanzeige)

8 RJ45-Buchse fir den Ethernet-Anschluss zur
Konfigurierung des Signalprozessors mithilfe
eines Computers

9 Wahlschalter fur die Eingangsempfindlichkeit
des Eingangs LINE A/MIC (10)
MIC = Mikrofon
LINE = Signalquelle mit Line-Pegel
Die Kontroll-LED neben dem Schalter leuch-
tet, wenn MIC gewahlt ist.

10 Eingang LINE A/MIC als kombinierte XLR-/
6,3-mm-Klinken-Buchse, darunter ein XLR-
Anschluss zum Weiterleiten des Eingangs-
signals z.B. an ein weiteres Lautsprecher-
system

11 Eingang LINE B als kombinierte XLR-/6,3-mm-
Klinken-Buchse, darunter ein XLR-Anschluss
zum Weiterleiten des Eingangssignals z.B.
an ein weiteres Lautsprechersystem

12 Eingang AUX als Cinch-Buchsen fir den Ein-
gangskanal B

13 XLR-Ausgang MIX OUT mit dem Mischsignal
der Eingange A und B zum Weiterleiten z.B.
an ein weiteres Lautsprechersystem

14 Kuhlrippen
15 Ein-/Ausschalter

16 PowerCon®-Netzausgangsbuchse AC LINK
zum Anschluss einer weiteren Lautsprecher-
box der MEGA-DSP-Serie (15> Kap. 4.5)

17 PowerCon®-Netzeingangsbuchse AC INPUT
zum Anschluss an eine Steckdose (230 V~/
50 Hz)

2 Hinweise fiir den
sicheren Gebrauch

Das Gerét entspricht allen relevanten Richtlinien
der EU und ist deshalb mit C€ gekennzeichnet.

WARNUNG Das Geréat wird mit lebensgeféhr-

licher Netzspannung versorgt.
Nehmen Sie deshalb niemals
selbst Eingriffe am Gerét vor und
stecken Sie nichts in die Luftungs-
schlitze. Es besteht die Gefahr
Beachten Sie auch unbedingt folgende Punkte:

eines elektrischen Schlages.

® Das Gerat ist nur zur Verwendung im Innen-
bereich geeignet. Schitzen Sie es vor Tropf-
und Spritzwasser, hoher Luftfeuchtigkeit und
Hitze (zulassiger Einsatztemperaturbereich
0-40°C).

® Stellen Sie keine mit Flissigkeit gefillten Ge-
faBe, z. B. Trinkglaser, auf das Gerét.

® Die im Gerat entstehende Warme muss durch
Luftzirkulation abgegeben werden. Decken
Sie darum die Luftungséffnungen und Kuhlrip-
pen (14) nicht ab. Stellen Sie die Box nie mit
der Ruckseite direkt an eine Wand; halten Sie
einen entsprechenden Abstand ein.

® Nehmen Sie das Gerat nicht in Betrieb und

ziehen Sie sofort den Netzstecker aus der

Steckdose,

1. wenn sichtbare Schaden am Gerat oder am
Netzkabel vorhanden sind,

2. wenn nach einem Sturz oder Ahnlichem der
Verdacht auf einen Defekt besteht,

3. wenn Funktionsstérungen auftreten.

Geben Sie das Gerat in jedem Fall zur Repa-

ratur in eine Fachwerkstatt.

® Ziehen Sie einen Netzstecker nie am Kabel
aus der Steckdose, fassen Sie immer am Ste-
cker an.

® Verwenden Sie fir die Reinigung nur ein tro-
ckenes, weiches Tuch, niemals Wasser oder
Chemikalien.

® Wird das Gerat zweckentfremdet, nicht richtig
angeschlossen, nicht sicher montiert, falsch
bedient oder nicht fachgerecht repariert, kann
keine Haftung fir daraus resultierende Sach-
oder Personenschaden und keine Garantie
fir das Geréat Gbernommen werden. Ebenso
kann keine Haftung fir durch Fehlbedienung
oder durch einen Defekt entstandene Daten-
verluste und deren Folgeschaden ubernom-
men werden.

b

Soll das Geréat endgultig aus dem Be-
trieb genommen werden, Ubergeben
Sie es zur umweltgerechten Entsor-
gung einem ortlichen Recyclingbetrieb.

3 Einsatzmdglichkeiten

Die Lautsprecherboxen der MEGA-DSP-Serie
sind leistungsféhige Aktiv-Lautsprecherboxen in
robusten Holzgehausen. Sie sind vielseitig ein-
setzbar, z. B. fir Tanzveranstaltungen, zur Aus-
stattung kleinerer Biihnen oder als Monitorlaut-
sprecher in einer Band. Die Lautsprecher sind
als 2-Wege-Systeme ausgefiihrt mit jeweils
einem eigenen Verstérker fur den Hochton- und
Tieftonbereich. Die Verstérker sind mit Schutz-
schaltungen gegen Uberlastung und Uberhit-
zung ausgestattet.

Die Lautsprecherboxen verfligen uber zwei
symmetrische Signaleingénge, von denen einer
auf Mikrofonempfindlichkeit umgeschaltet wer-
den kann. Fur den anderen Eingang gibt es
zudem auch asymmetrisch beschaltete An-
schliisse. Zusatzliche Signalausgange ermdgli-
chen z.B. den Anschluss weiterer Aktiv-Laut-
sprecherboxen.

Kern der MEGA-DSP-Serie ist der digitale
Signalprozessor (DSP). Er bietet vielseitige
Méglichkeiten zur Klangverénderung, Laufzeit-
korrektur und zur Dynamikbegrenzung. Uber ein
Computernetzwerk lasst sich der DSP fernsteu-
ern. Verschiedene Konfigurationen kénnen als
Presets in der Lautsprecherbox gespeichert
werden und so auch im Einzelbetrieb wieder
abgerufen werden.

4 Aufstellen und AnschlieBen

Die Lautsprecherbox auf einen festen Unter-
grund z. B. auf die Bihne oder einen Tisch stel-
len und auf die Zuhorer ausrichten. Mit ihrer
abgeschragten Gehauseform kann die Box auch
als schrag nach oben abstrahlender Buhnenmo-
nitor eingesetzt werden. Soll ein Mikrofon ver-
wendet werden, den Lautsprecher nicht auf das
Mikrofon richten und gentigend Abstand zum
Mikrofon halten, da es sonst zu einer akusti-
schen Ruckkopplung (lauter Pfeifton) kommen
kann.

Alternativ kann die Lautsprecherbox Uber
die Stativhilse in der Unterseite auf ein Stan-
dard-Lautsprecherstativ mit 35 mm Rohrdurch-
messer gestellt werden (z.B. aus der PAST-
Serie von ,img Stage Line").

Fir zusatzliche Montagemdglichkeiten sind
mehrere M8-Gewindebuchsen in das Gehéuse
eingelassen. Daran kénnen z. B. Montagebugel
(MHB-.../MVB-...) oder die beiliegenden Ring-
schrauben fir eine Aufhdngung befestigt wer-
den. Um die Gewindebuchsen zu nutzen, die
betreffenden Abdeckschrauben (Inbus) entfer-
nen.

Bei der Positionierung der Lautsprecherbox
immer darauf achten, dass Luft ungehindert
durch die Kuhlrippen (14) an der Riickseite stro-
men kann, damit eine ausreichende Kiihlung
gewdhrleistet ist.

WARNUNG Nicht fachgerecht ausgefiihrte
Installationen, besonders bei Uber
Personen hangenden Systemen,
stellen eine potentielle Gefahr dar.
Darum darf die Installation nur von
Fachpersonal mit Kenntnissen der
gultigen Normen und Sicherheits-
vorschriften durchgeflihrt werden.
Die Installation, insbesondere die Stabilitat der
Montageverbindungen, ist entsprechend regel-
maBig zu kontrollieren.

4.1 Hochtoéner drehen

Soll die Lautsprecherbox hauptséchlich in hori-
zontaler Lage betrieben werden (z.B. als
Bodenmonitor), kann der Hochténer um 90°
gedreht werden, um eine breitere Abstrahlung
der Hohen zu erreichen. Dazu die Metallfront
entfernen (Schrauben seitlich), die vier Schrau-
ben des Hochténers entfernen und ihn um 90°
gegen den Uhrzeigersinn gedreht wieder fest-
schrauben.
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@ 4.2 Signalquelle anschlieBen

Vor dem Anschluss bzw. vor dem Andern beste-
hender Anschliisse die Lautsprecherbox und die
anzuschlieBenden Gerate ausschalten.

Fur den Anschluss einer Signalquelle mit Line-
Pegel (z. B. CD-Spieler, Mischpultausgang) gibt
es folgende Mdglichkeiten:

— Fur symmetrische Signale eignen sich die
kombinierten XLR-/6,3-mm-Klinken-Buchsen
LINE A/MIC (10) und LINEB (11) [die Bele-
gung der Kontakte ist am Geréat aufgedruckt,
siehe Abbildung].

— Fir asymmetrische Signale eignen sich die
Cinch-Buchsen AUX (12). Bei der gleichzeiti-
gen Nutzung beider Cinch-Buchsen oder der
Cinch-Buchsen und der Buchse LINEB (11)
werden die Eingangssignale gemischt. Da-
durch wird beim Anschluss einer Stereo-Sig-
nalquelle ein Monosignal erzeugt. Fir die
stereophone Wiedergabe jeden Stereokanal
an eine eigene Lautsprecherbox anschlie-
Ben.

Ein asymmetrisches Monosignal kann
auch uber einen zweipoligen Klinkenstecker
an die Buchse LINE A/MIC (10) oder LINE B
(11) angeschlossen werden.

Ein Mikrofon l&sst sich an die kombinierte
XLR-/6,3-mm-Klinken-Buchse LINEA/MIC (10)
anschlieBen. Die Buchse ist fir beide Steckerty-
pen flir symmetrische Signale beschaltet.

Ein Mikrofon mit asymmetrischem Aus-
gangssignal kann mit einem zweipoligen Klin-
kenstecker an die Klinkenbuchse angeschlos-
sen werden.

Zum Herausziehen eines XLR-Steckers aus der
Buchse den PUSH-Hebel driicken.

4.2.1 Eingangsempfindlichkeit wéhlen

Ist am Eingang LINE A/MIC (10) ein Mikrofon
angeschlossen, den Schiebeschalter LINE/MIC
(9) zur Erhéhung der Eingangsempfindlichkeit in
die Position MIC stellen. Die Kontroll-LED neben
dem Schalter leuchtet dann. Fir den Anschluss
einer Signalquelle mit Line-Pegel den Schalter in
die Position LINE stellen.

4.3 Signalausgédnge

Zum Weiterleiten eines Eingangssignals an wei-
tere Lautsprechersysteme oder an ein Aufnah-
megerat stehen jeweils die XLR-Buchsen unter-
halb der Eingangsbuchsen (10 und 11) zur
Verfligung. An der Buchse MIX OUT (13) liegt
zusétzlich das Mischsignal der Eingénge LINE A/
MIC, LINE B und AUX an.

4.4 Computer

Zum Fernsteuern der Lautsprecherbox oder
zum Konfigurieren der Presets die Lautspre-
cherbox Uber die Buchse ETHERNET (8) mit
einem einzelnen Computer oder einem Compu-
ternetzwerk verbinden (1= Kap. 6).

4.5 Netzanschluss
Zur Stromversorgung die Lautsprecherbox uber
die PowerCon®-Buchse AC INPUT (17) an das
230-V-Netz anschlieBen. Ein Netzkabel liegt
dem Gerét nicht bei. Es kann ein Netzkabel mit
einem PowerCon®-Stecker und einem Schuko-
stecker (z.B. AAC-115P von ,img Stage Line®)
verwendet werden.

Uber die PowerCon®-Netzausgangsbuchse
AC LINK (16) kann eine weitere Lautsprecher-
box angeschlossen werden. Auf diese Weise
dirfen maximal vier Lautsprecherboxen der
MEGA-DSP-Serie miteinander verbunden wer-
den.

Hinweis: Ein PowerCon®-Stecker darf weder unter Last
noch unter Spannung ein- oder ausgesteckt werden.
Stellen Sie darum immer zuerst die PowerCon®-Verbin-
dung her, dann die Netzverbindung und trennen Sie die
Netzverbindung vor der PowerCon®-Verbindung.

5 Bedienung

VORSICHT: Die Einstellung der Lautstarke er-
folgt digital Uber die beiden Endlosdrehkndpfe
(5, 6) oder per Fernsteuerung Uber ein Netz-
werk. Daher kann diese Einstellung vor dem Ein-
schalten des Geradtes weder veréndert noch
abgelesen werden. Ist nicht bekannt, mit wel-
cher Einstellung die Lautsprecherbox nach dem
Einschalten beginnt, sollten die Signalquellen
zunachst ausgeschaltet bleiben.

Die Lautsprecherbox mit dem Schalter POWER
(15) einschalten. Die LED POWER (1) leuchtet
sowie die LED auf der Vorderseite der Lautspre-
cherbox. Das Display (4) zeigt in der oberen
Zeile den Namen der Lautsprecherbox, in der
unteren Zeile den Namen des aktuellen Presets.

Sobald Uber ein Netzwerk die Verbindung
zu dem Steuerprogramm auf einem Computer
hergestellt worden ist, zelgt dle untere Zeile des
Displays E :. Eine Bedie-
nung an der Lautsprecherbox ist dann nicht
mehr moglich.

5.1 Betrieb ohne Computer

Fur den Einzelbetrieb darf die Lautsprecherbox
nicht (Uber ein Netzwerk) mit einem Computer
verbunden sein, auf dem das Steuerprogramm
lauft.

1) Mit dem Regler ,MASTER VOLUME" (5) die
Lautstarke fur den Eingang LINE A/MIC (10)
einstellen.

2) Mit dem Regler ,SELECT/ENTER" (6) die
Lautstarke flr den Eingang LINEB (11) und
AUX (12) einstellen.

Der eingestellte Verstarkungswert (in dB) wird
jeweils im Display (4) angezeigt, z. B.:

T e

Sind die beiden Eingangskanéle bei einem Pre-
set gekoppelt, steht in der oberen Zeile stattdes-
sen:

T e

Mit beiden Reglern wird dann immer die Laut-
starke fir beide Kanéle gemeinsam eingestellt.

VORSICHT Stellen Sie die Lautstarke nie sehr

t hoch ein. Hohe Lautstarken kén-

nen auf Dauer das Gehor schadi-
gen! Das Ohr gew6hnt sich an sie
und empfindet sie nach einiger Zeit
als nicht mehr so hoch. Darum eine
hohe Lautstarke nach der Gewdh-
nung nicht weiter erhdhen.

Funktionen der Status-LEDs (1)

— Die LEDs SIGNALA und SIGNALB zeigen
an, wenn ein Signal am entsprechenden Ein-
gang anliegt und die Lautstarkeeinstellung
(Gain) nicht zu niedrig gewéhlt ist.

— Die LED LIMITER leuchtet, sobald die Pegel-
begrenzung fir einen Eingangskanal aktiv ist.

— Die LED PROTECT leuchtet, wenn eine

Schutzschaltung anspricht sowie kurz bei
jedem Ein- und Ausschalten.

Hinweis: Alle durchgefiihrten Einstellungen bleiben
nach dem Ausschalten erhalten, wenn die Startvorga-
ben ,Power On Preset* flr die Lautsprecherbox auf
sLast Setting“ eingestellt sind (1= Kap. 6.6.4).

5.1.1

Hinweis: Diese Funktion ist vom Werk firr jeden Benut-
zer verfligbar. Sie kann aber (ber die Einstellungen
(1= Kap. 6.6.6) gesperrt werden.

Preset aufrufen

Zum Aufrufen eines Presets:

1) Die Taste MENU (2) driicken, sodass im Dis-
play (4) L.cxzci® | dahinter die Speicherplatz-
nummer und darunter der Name des zuletzt
gewahlten Presets angezeigt wird.

Die ersten fiinf Speicherplatze sind mit
fest vorgegebenen Presets belegt, die bri-
gen kénnen selbst konfiguriert werden.

Durch Drehen des Knopfes SELECT/ENTER
(6) das gewlinschte Preset auswahlen und
durch Driicken desselben Knopfes bestati-
gen. Die folgende Meldung erscheint:

n

3) Zum Laden des gewahlten Presets den
Knopf SELECT/ENTER nach rechts drehen,
sodass die Anzeige wechselt auf:
Load P t
]
Den Knopf SELECT/ENTER driicken. Das
Preset wird jetzt geladen. Wahrend des
Ladevorgangs wird hinter dem Namen des
Presets ein # gezeigt.

&

Bei den beschriebenen Schritten fiihrt das Dri-
cken der Taste ESC (3) jeweils zum Abbruch
des Vorgangs, ebenso das Warten von ldnger
als einer Minute.

5.1.2 Systeminformationen anzeigen
Zum Anzeigen von Systeminformationen:

1) Die Taste MENU (2) so oft drucken bis |m
Dlsplay (4) der Begrlff [

zelgt W|rd

2) Durch Drehen des Knopfes SELECT/ENTER
(6) kdbnnen weitere Informationen angezeigt
werden.

Bei den beschriebenen Schritten fiihrt das Dri-
cken der Taste ESC (3) jeweils zum Abbruch
des Vorgangs, ebenso das Warten von langer
als einer Minute.

5.1.3 Sperrung aufheben

Nach jedem Einschalten befindet sich die Laut-
sprecherbox in gesperrtem Zustand mit einge-
schrénkten Bedienmdglichkeiten. Welche Optio-
nen in diesem Zustand noch zur Verfligung
stehen, kann in den Einstellungen der Lautspre-
cherbox tber den Computer festgelegt werden
(r=> Kap. 6.6.6). Durch die Eingabe des Pass-
wortes fir die Lautsprecherbox wird die Sper-
rung aufgehoben. Das Passwort ist vom Werk
vorgegeben als ,monacor”, kann aber flr jede
Lautsprecherbox individuell geé&ndert werden
(r=> Kap. 6.6.2 oder Kap. 5.1.4).

1) Die Taste MENU (2) so oft driicken, bis im
Display (4) =1 angezeigt wird.
Durch Drehen des Knopfes SELECT/ENTER
(6) die Option Lirt1 ok cd wahlen und durch
Driicken des Knopfes bestatlgen Das Dis-
play zeigt jetzt Erf. i ‘i

»

Das erste Zeichen des Passwortes fir diese
Lautsprecherbox durch Drehen des Knopfes
SELECT/ENTER auswéhlen und durch Dri-
cken des Knopfes zur néchsten Zeichenposi-
tion springen.

&L

Alle weiteren Zeichen des Passwortes auf
dieselbe Art eingeben, jedoch nach der Wahl
des letzten Zeichens nicht den Knopf dru-
cken. Mit der Taste ESC (3) kann zur Korrek-

=



tur der Eingabe jeweils eine Zeichenposition
zurlickgesprungen werden.

5) Ist das Passwort vollstéandig, die Eingabe mit
der Taste MENU bestétigen.

5.1.4 Gerét sperren, Passwort é@ndern
Um das Gerét im Betrieb wieder zu sperren und
dabei, wenn gewunscht, das Passwort zu &ndern:

1) Die Taste MENU (2) so oft driicken, bis im
Display (4 =1 angezeigt wird.
2) Durch Drehen des Knopfes SELECT/ENTER
(6) die Option :
len und durch Driicken des Knopfes bestatl-
gen Das Display zeigt jetzt et -
4 an und darunter das aktuelle Passwort
der Lautsprecherbox.

Soll das Passwort nicht geéndert werden,
dieses mit der Taste MENU bestéatigen und
mit Schritt 6 fortfahren.

Soll die Lautsprecherbox ein neues Pass-

wort erhalten, das angezeigte Passwort Uber-
schreiben. Dazu das erste Zeichen des
neuen Passwortes durch Drehen des Knop-
fes SELECT/ENTER auswahlen und durch
Driicken des Knopfes zur néchsten Zeichen-
position springen.
Alle weiteren Zeichen des neuen Passwortes
auf dieselbe Art eingeben, jedoch nach der
Wahl des letzten Zeichens nicht den Knopf
dricken. Mit der Taste ESC (3) kann zur Kor-
rektur der Eingabe jeweils eine Zeichenposi-
tion zurtickgesprungen werden.

Das Passwort darf aus max. 8 Zeichen
bestehen. Ist das neue Passwort kirzer als
das alte, die alten Zeichen am Ende mit Leer-
zeichen uberschreiben.

5) Ist das Passwort vollstandig, die Eingabe mit
der Taste MENU bestatigen. Es wird eine
weltere Bestatlgung mit der Anzeige I

- erwartet.

L

K

6) Fur die erneute Bestatigung die Taste MENU
driicken oder zur Korrektur der Passwortein-
gabe die Taste ESC.

Wichtig: Das neue Passwort gut merken! Bei
Verlust des Passwortes kann fiir die Einstel-
lungen tiber einen Computer nicht mehr auf die
Lautsprecherbox zugegriffen werden. Die ver-
bleibenden Einstellméglichkeiten an der Laut-
sprecherbox hangen von der aktuellen Einstel-
lung der Zugriffsrechte (1> Kap. 6.6.6) ab.

6 Fernsteuerung liber

einen Computer
In der Lautsprecherbox befindet sich ein digitaler
Signalprozessor (DSP), der zum einen die Auf-
teilung des Signals auf den Basslautsprecher
und den Hochtonlautsprecher ubernimmt und
zum anderen vielseitige Moglichkeiten zur Fre-
quenzgangkorrektur, Laufzeitkorrektur und zur
Dynamikbegrenzung bietet. Vom Werk aus ist
der DSP bereits einsatzbereit konfiguriert. Es
stehen finf Presets mit verschiedener Klangcha-
rakteristik zur Auswahl. Fir eigene Einstellun-
gen, z.B. zur Anpassung der Anlage an die
Raumakustik, dient die mitgelieferte Computer-
Software. Uber die Ethernetschnittstelle (8) kann
die Lautsprecherbox mit einem einzelnen Com-
puter, einem lokalen Computernetzwerk oder,
z.B. Uber einen Router, mit gréBeren Computer-
netzwerken (Internet) verbunden werden. Fir die
korrekte Einrichtung der Verbindung sind unbe-
dingt Netzwerktechnik-Kenntnisse erforderlich.
Hinweis: Bei einer direkten Verbindung der Lautspre-
cherbox mit einem Computer kann die Verwendung
eines Crossover-Kabels oder eines entsprechenden
Adapters erforderlich sein.

6.1 Installation der PC-Software
Systemvoraussetzung fir die Installation des
mitgelieferten Steuerprogramms ist ein Compu-
ter mit dem Betriebssystem Windows XP mit
Service Pack 2 oder einer hdheren Windows-
Version oder Mac OS X ab Version 10.5.8 und
einer Ethernet-Schnittstelle. Die Bildschirmauf-
I6sung sollte mindestens 1024 x 768 Bildpunkte
betragen. Fur die Installation der PC-Software
das Installationsprogramm ,Setup.exe” oder
»oetup [...] .msi“ bzw. ,[...] Controller.mpkg“ (fur
Mac OS X) auf der mitgelieferten CD starten
und den Anweisungen des Installationspro-
gramms folgen.

Windows ist ein registriertes Warenzeichen der Microsoft Corporation in den

USA und anderen Léandern. Mac OS ist ein registriertes Warenzeichen von
Apple Computer, Inc. in den USA und anderen Léandern.

6.2 Einrichten der Netzwerkverbindung
Vom Werk ist die Lautsprecherbox auf den auto-
matischen Bezug der Netzwerkeinstellungen von
einem DHCP-Server in einem bestehenden Netz-
werk voreingestellt. Existiert in dem angeschlos-
senen Netzwerk kein DHCP-Server, wird die
Lautsprecherbox automatisch selbst zum DHCP-
Server und teilt den anderen Teilnehmern des
Netzwerkes jeweils eine IP-Adresse zu, wenn
diese Teilnehmer auf den automatischen Bezug
von Netzwerkeinstellungen eingestellt sind.

Sollen im Netzwerk nur feste IP-Adressen
verwendet werden, kann der Lautsprecherbox
auch manuell eine bestimmte Adresse zugeteilt
werden (1= Kap. 6.6.3).

Die zuletzt eingestellte IP-Adresse einer
Lautsprecherbox kann im Einzelbetrieb uber das
Menu angezeigt werden (1= Kap. 5.1.2).
Hinweis: Damit die Lautsprecherbox Uber das Pro-
gramm konfiguriert werden kann, miissen der Compu-
ter und die Lautsprecherbox demselben Teilnetz ange-
horen. Ist dies nicht der Fall, kann es sinnvoll sein, die
Lautsprecherbox zunéchst allein an einen Computer
anzuschlieBen, der seine Netzwerkeinstellu__ngen auto-
matisch von der Lautsprecherbox bezieht. Uber die so
erstellte Verbindung ist es anschlieBend mdglich, die
Netzwerkeinstellungen der Lautsprecherbox dem vor-
gesehenen Netzwerk anzupassen.

6.3 Steuerprogramm
1) Auf dem Computer das Steuerprogramm
MG Stage Line DSP Controller” aufrufen.

Es erscheint ein Fenster zur Eingabe des
Passwortes fir den Start des Programms. Die
Vorgabe ist ,monacor“. Das Passwort kann
aber spater vom Anwender geéndert werden.

2) Das Passwort eingeben (ohne Anflihrungs-
zeichen und unter Beachtung der Schreib-
weise).
Bei falsch eingegebenem Passwort er-
scheint die Meldung ,Invalid password!”. In
diesem Fall die Meldung bestatigen und das
Passwort erneut eingeben.
Das Ubersichtsfenster (Abb. 2) wird angezeigt.
Darin erscheint eine Liste aller verbundenen
Lautsprecherboxen.

In der oberen Zeile ,All Units“ wird in Klam-
mern angegeben, wieviele Lautsprecherboxen

== MG Stage Line DSP Controller,
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momentan ,online“ sind, d. h. in aktiver Verbin-
dung mit dem Computer stehen.

Darunter gibt es fur jede Lautsprecherbox
eine Zeile mit verschiedenen Informationen und
Funktionen in den im Folgenden beschriebenen
Spalten:

Info

Schaltflache [M] zum Stummschalten der Laut-
sprecherbox. Wahrend der Stummschaltung ist
die Schaltflache rot. Zum Wiedereinschalten des
Tons erneut auf die Schaltflache klicken. Das Kii-
cken auf die Schaltflache M in der Zeile ,All
Units* fihrt zur gleichzeitigen Stummschaltung
aller verbundenen Lautsprecherboxen.

Schaltflache [L] zum Lokalisieren und Identifizie-
ren einer Lautsprecherbox. Nach dem Klicken
auf die Schaltflache blinkt diese fir einige Se-
kunden und mit ihr alle Status-LEDs (1) auf der
Ruckseite der entsprechenden Lautsprecher-
box.

Das farbige Feld () gibt den Verbindungsstatus
an. Es ist bei verbundenen Geraten griin, bei
unterbrochener Verbindung gelb. Wahrend beim
Einschalten einer Lautsprecherbox eine neue
Verbindung aufgebaut wird, erscheint am Ende
der Liste vorubergehend eine zuséatzliche Zeile
LStartup...“ mit einem orangefarbenen Feld.

Die beiden senkrechten Balken neben dem far-
bigen Feld stellen eine einfache Pegelanzeige
fur den Tiefton- und den Hochtonverstarker der
Lautsprecherbox dar.

Name

Hier wird der Name der Lautsprecherbox ange-
zeigt. Der voreingestellte Name kann zur Unter-
scheidung der Lautsprecherboxen spater geén-
dert werden (1> Kap. 6.6.1).

Reference

Hier wird die Hardware-Adresse (MAC-Adresse)
der Netzwerkschnittstelle der Lautsprecherbox
angezeigt. Hierlber l&sst sich eine Lautspre-
cherbox immer eindeutig identifizieren.

Address

Hier wird die IP-Adresse einer verbundenen
Lautsprecherbox angezeigt. Bei unterbrochener
Verbindung steht an dieser Stelle ,Offline“.

Group

Im Listenfeld wird die aktuelle Gruppenzugehé-
rigkeit der Lautsprecherbox angezeigt. Uber die
Liste kann die Lautsprecherbox auch einer
anderen Gruppe zugeordnet werden (Funktion
der Gruppen = Kap. 6.3.1). Die Option ,Not
Grouped* bedeutet, die Lautsprecherbox ist kei-
ner Gruppe zugeordnet.

Launch

Ist eine Lautsprecherbox ,online®, kann tber die
Schaltflache [>>] in dieser Spalte das entspre-
chende Konfigurationsfenster (Abb. 5) aufgeru-
fen werden. In der Zeile , All Units* kann Uber die
Schaltflache [Close] die Liste der Lautsprecher-
boxen ausgeblendet oder Uber [Open] wieder
eingeblendet werden.

=0
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6.3.1 Gerategruppen

Mehrere Lautsprecherboxen kénnen zur ge-
meinsamen Steuerung in Gruppen zusammen-
gefasst werden. Sie kénnen so z. B. gemeinsam
stummgeschaltet werden. Wird fir eine Laut-
sprecherbox der Gruppe eine Einstellung gean-
dert, so gilt diese Anderung fir alle Mitglieder
derselben Gruppe. Dabei kann die Zugehorig-
keit einer Lautsprecherbox zu einer Gruppe
jederzeit geandert werden.

6.3.1.1 Neue Gruppe bilden
1) Zum Anlegen einer neuen Gruppe den Menu-
punkt ,Tools » New Group*“ aufrufen.

2) Im angezeigten Fenster in das Feld ,Enter
the name of the new group:“ den gewunsch-
ten Gruppennamen eingeben.

Am Ende der Lautsprecherliste wird jetzt
eine zusatzliche Zeile fir die Gruppe gezeigt
(Zeile ,Group: ...%).

3) In der Zeile jeder als Gruppenmitglied ge-
winschten Lautsprecherbox im Listenfeld
unter ,,Group“ die neue Gruppe auswahlen.

Eine Lautsprecherbox kann auf diese
Weise jederzeit wieder aus der Gruppe ent-
fernt (,Not Grouped“ wahlen) oder einer
anderen Gruppe zugeordnet werden.

In der Zeile ,Group: ...“ wird jeweils die
aktuelle Anzahl der Gruppenmitglieder ange-
zeigt (members).

4) Uber die Schaltfliche [Open] am Ende der
Zeile ,,Group: ...“ kann direkt unter der Zeile
eine Liste aller Gruppenmitglieder gezeigt
und Uber [Close] wieder ausgeblendet wer-
den (1> Abb. 3 — hier sind zwei Mitglieder
angezeigt).

6.3.1.2 Gruppe léschen

Zum Ldschen einer Gruppe in der Zeile fur diese
Gruppe auf die Schaltflache [Delete] klicken
(r=> Abb. 3). Es erscheint eine Sicherheitsab-
frage zur Bestatigung des L&schvorgangs.
Wenn der Gruppe zu diesem Zeitpunkt Laut-
sprecherboxen zugeordnet sind, erscheint zu-
séatzlich der Hinweis, dass die Lautsprecherbo-
xen damit automatisch den Eintrag ,Not Grouped*
erhalten.

6.3.2 Programmpasswort &ndern
Um das Passwort fur den Start des Programms
zu &ndern:

1) Den Menlpunkt ,Tools »Change Software
Password* aufrufen.

2) Im angezeigten Fenster in das Feld ,Enter
Old Password:“ das bisherige Passwort ein-
geben (vom Werk voreingestellt ist ,mona-
cor”).

3) Im nun angezeigten Fenster in das Feld
~Enter New Password:“ das neue Passwort
eingeben.

File Tools Help

EEX
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4) Im anschlieBend angezeigten Fenster in das
Feld ,Confirm New Password:* das neue
Passwort zur Bestatigung noch einmal einge-
ben und gut merken!

6.3.3 Demo-Modus

Ist keine Lautsprecherbox mit dem Computer
verbunden, lasst sich zu Demonstrationszwe-
cken eine virtuelle Lautsprecherbox erzeugen.
Dazu den Menlpunkt ,Tools »Enter Demo
Mode" aufrufen.

In der Liste erscheint jetzt die virtuelle Laut-
sprecherbox mit dem Namen ,Mega DSP* und
der Bezeichnung ,DEMO...“ in der Spalte ,Refe-
rence”. Wie bei realen Lautsprechern kann hier
Uber die Schaltflache [>>] das Konfigurations-
fenster aufgerufen werden (1> Abb. 5).

Um die virtuelle Lautsprecherbox wieder aus
der Liste zu entfernen, den Menlpunkt ,Tools
» Leave Demo Mode* aufrufen.

6.3.4 Firmware Update

Fir eine reibungslose Kommunikation zwischen
dem Steuerprogramm und einer Lautsprecher-
box mussen beide zueinander passende Versio-
nen haben. Liegt das Steuerprogramm in einer
neueren Version vor, kann die Firmware (Be-
triebssystem) der Lautsprecherbox Uber das
Steuerprogramm aktualisiert werden. Dabei
gehen alle in der Lautsprecherbox gespeicher-
ten Einstellungen verloren. Sollen die Einstellun-
gen erhalten bleiben, missen sie vor der Aktua-
lisierung auf dem Computer gesichert werden
(r=> Kap. 6.5.5).

Hinweis: Eine Firmware-Aktualisierung geschieht auf
eigenes Risiko. Nach einem Update kann die Funk-
tionsweise des Gerates anders sein als in dieser Bedie-
nungsanleitung beschrieben.

VORSICHT: Schalten Sie die Signalquellen aus
oder reduzieren Sie deren Ausgangspegel, damit
es nach dem Zurlcksetzen der Einstellungen
nicht zu unerwartet hoher Lautstarke kommt.

Um die Firmware einer Lautsprecherbox auf den
neuesten Stand zu bringen, den Menupunkt
sT00ls #Enable Update“ aufrufen. Am rechten
Rand der Liste wird jetzt zuséatzlich die Spalte
+Update“ angezeigt.

1) In der Zeile der entsprechenden Lautspre-
cherbox unter ,Update” auf die Schaltflache
[>>] klicken.

2) Es erscheint ein Hinweis, dass die Lautspre-
cherbox wahrend der mehrschrittigen Aktua-
lisierung nicht ausgeschaltet oder die Verbin-
dung getrennt werden darf. Schlagt die
Aktualisierung fehl, muss sie erneut gestartet
werden.

Die Aktualisierung mit [OK] starten oder
mit [Cancel] abbrechen.

Nach erfolgter Aktualisierung wird noch eine
Meldung angezeigt. Diese ebenfalls bestati-
gen.

L

Stellt das Programm fest, dass die Firm-
ware der Lautsprecherbox bereits auf dem
aktuellen Stand ist, werden die Einstellungen
nicht auf die Werksvorgaben zurlickgesetzt.

4) Zum Wiederherstellen der modellspezifi-
schen Werksvoreinstellungen (Preset 1-5)
das Konfigurationsfenster der Lautsprecher-
box aufrufen und die Funktion ,Hardware
»Load Factory Presets® wéhlen (1= Kap.
6.5.7).

Um in der Liste die Spalte ,Update” wieder aus-
zublenden, den Menipunkt ,Tools #Disable
Update“ aufrufen.

Hinweis: Bei einem Ruicksetzen der Einstellungen auf
die Werksvorgaben sind auch die Netzwerkeinstellun-
gen und das Passwort der Lautsprecherbox betroffen,
d. h. es kann mdglicherweise zunachst vom Computer
nicht mehr auf die Lautsprecherbox zugegriffen wer-
den.

6.3.5 BGM-Player

Uber den Meniipunkt ,Tools #BGM Player
» Open File/Open Directory“ kann ein kleines
Hilfsprogramm zum Abspielen von Audio-
Dateien auf dem Computer gestartet werden.
Dabei fuhrt ,Open File“ zur Wiedergabe einer
einzelnen Datei, ,Open Directory” zur Wieder-
gabe aller Dateien in einem Verzeichnis.

Zur Wiedergabe Uber eine Lautsprecherbox
ist es erforderlich, den Audio-Ausgang des Com-
puters mit dem Audio-Eingang (12) des ge-
winschten Lautsprechers zu verbinden.

6.3.6 Programm beenden

Zum Beenden des Programms den MenUpunkt
L,File » Quit* aufrufen oder das Programmfenster
schlieBen.

6.4 Lautsprecher konfigurieren

Achtung!

Der Signalprozessor ist in Verbindung mit dem
Steuerprogramm ein effektives Werkzeug, mit
dem sehr feine, aber auch gravierende Ande-
rungen der Ubertragungseigenschaften des
Lautsprechersystems mdglich sind.

Jede Anderung der Parameter sollte
deshalb mit Bedacht und Sachverstand vorge-
nommen werden. Extreme Anderungen der
Einstellungen koénnen schlimmstenfalls zur
Schéadigung des Lautsprechersystems flihren.

1) Zur Konfiguration einer Lautsprecherbox in
der Spalte ,Launch” der Liste (1= Abb. 2, 3)
auf die Schaltflache [>>] klicken.

n

Ein Dialogfenster wird eingeblendet. Der
Name der entsprechenden Lautsprecherbox
und ihre MAC-Adresse werden im Listenfeld
angezeigt.

Wenn gewuinscht, hier eine andere Laut-
sprecherbox wahlen.

3) Das Passwort flr die gewahlte Lautsprecher-
box in das Feld unter ,Password” eingeben.
Das Passwort ist vom Werk vorgegeben als
,monacor“, kann aber fir jede Lautsprecher-
box individuell geéndert werden (1> Kap.
6.6.2 oder Kap. 5.1.4).

Das Hauptfenster (Abb. 5) fir die gewéhlte
Lautsprecherbox wird angezeigt. Auf der lin-
ken Seite wird als Farbfeld neben UNIT
CONNECTION der Verbindungsstatus der
Lautsprecherbox angezeigt. Bei griinem Feld
besteht eine Datenverbindung. Bei rotem
Feld ist die Verbindung unterbrochen, das
Andern einer Einstellung ist dann nicht még-
lich. Bei einem Versuch erscheint eine ent-
sprechende Meldung.

Uber die Schaltflachen [ IN-A]und [ IN-B ]
kann auf die Konfigurationsfenster der bei-

=
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den Eingangssignalwege umgeschaltet wer-
den (Abb. 6). Uber die Schaltflache [ MAIN ]
gelangt man zurlck ins Hauptfenster.

Auf dem Bildschirm geénderte Einstellungen
werden bei bestehender Verbindung sofort zu
der Lautsprecherbox Ubertragen. Die Einstellun-
gen kdénnen auf dem Computer (1=° Kap. 6.5.3)
und in der Lautsprecherbox (1=° Kap. 6.5.2) als
Preset gespeichert werden. Zudem kann festge-
legt werden, ob beim Einschalten der Lautspre-
cherbox immer ein bestimmtes Preset geladen
werden soll oder der letzte Zustand vor dem
Ausschalten (1= Kap. 6.6.4).

In der Abbildung 4 ist der Signalweg durch
das Verstarkersystem als Blockdiagramm dar-

% mega-dsp10 (B8:96:74:00:05:7C)

gestellt. Von den beiden Eingangen auf der
linken Seite durchlaufen die Signale nach der
Analog-Digital-Umwandlung zunéachst den Ein-
gangsverstarker (GAIN), die 10-bandige Klang-
einstellung (EQ) und die Pegelbegrenzung
(LIMITER), bevor sie summiert werden. Flr das
entstandene Mischsignal kann dann eine Verzo-
gerung (DELAY) und ein Hochpassfilter (LOW
CUT) eingestellt werden. Der bisher beschrie-
bene, im Diagramm umrahmte Signalweg kann
vom Anwender konfiguriert werden. Die danach
folgende Signalverarbeitung ist vom Werk aus
festgelegt: Frequenzaufteilung auf die beiden
Ausgangszweige HF und LF, jeweils Verstéar-
kung, Klangkorrektur, Signalverzégerung, Pegel-
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begrenzung, Digital-Analog-Wandlung. Das LF-
Signal wird auf den Verstarker (Klasse D) des
Basslautsprechers, das HF-Signal auf den Ver-
starker (Klasse AB) fur den Hochtonlautsprecher
weitergeleitet.

6.4.1 Verstéarkung einstellen
Die Verstarkung lasst sich fur beide Eingangs-
signale getrennt einstellen. Dazu dienen die Re-
gler INPUT CONTROL im Hauptfenster (Abb. 5)
oder der Regler GAIN im Konfigurationsfenster
des jeweiligen Eingangs IN-A (Abb. 6) und IN-B.
Alternativ zum Verschieben eines Reglers mit-
hilfe der Maus lasst sich der Wert auch nume-
risch (in dB) in das Feld darunter eingeben.
Parallel neben den Reglern befindet sich
jeweils eine Balkenanzeige fir den Eingangs-
pegel. Die Anzeigen der resultierenden Pegel fur
den Hochtonlautsprecher (HF) und den Bass-
lautsprecher (LF) befinden sich auf der rechten
Seite des Hauptfensters.

6.4.2 Eingang stummschalten

Zum Stummschalten eines Eingangs auf den
jeweiligen Knopf MUTE unter dem entsprechen-
den Verstarkungsregler im Hauptfenster oder im
Konfigurationsfenster des jeweiligen Eingangs
IN-A und IN-B klicken. Der Knopf hat wahrend
der Stummschaltung eine rote Umrandung. Zum
Wiedereinschalten des Tons erneut auf den
Knopf klicken.

6.4.3 Klangkorrektur

Im unteren Bereich des Konfigurationsfenster
der Eingange IN-A und IN-B stehen 10 parame-
trische Equalizer (Filter) zur Verflgung. Durch
die Kombination dieser Filter lassen sich sehr
komplexe Klangkorrekturen durchfuhren (z.B.
zur Anpassung an die Raumakustik).

1) Durch Klicken auf den Knopf ON am Anfang
einer Filterzeile das entsprechende Filter ein-
schalten (der Knopf wird griin umrandet) oder
wieder ausschalten.

2) Im Feld TYPE die Filtercharakteristik wahlen:
Bell, Notch, AllPass, Low Shelf, High Shelf,
Band Pass, High Pass oder Low Pass

3) In das Feld FREQ. die gewunschte Filterfre-
quenz eingeben.

4) In das Feld Q die gewlinschte Filtergite ein-
geben oder alternativ die relative Bandbreite
BW. Durch Klicken auf [Q] bzw. [BW] kann
zwischen diesen beiden Parametern umge-
schaltet werden.

5) In das Feld GAIN die gewlinschte Verstar-
kung eingeben. Die Verfugbarkeit dieses
Parameters ist von der gewahlten Filtercha-
rakteristik abhangig.

6.4.3.1 Frequenzgang

Die Auswirkungen der Filtereinstellungen auf
den Amplituden-Frequenzgang werden als Kur-
ven angezeigt. Dabei gehért zu jedem Filter ein
Bezugspunkt (kleines Quadrat mit der Filternum-
mer) und eine Frequenzkurve in einer eigenen
Farbe. Der resultierende Frequenzgang aller
aktiven Filter ist als weiBBe Kurve dargestellt.
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Die Filterparameter kénnen zum Teil auch gra-
fisch eingestellt werden. Dazu mit der Maus den
jeweiligen Bezugspunkt verschieben:

— Anderung der Frequenz durch horizontales
Verschieben

— Anderung der Verstarkung durch vertikales
Verschieben

— Anderung der Filtergiite/Bandbreite durch
horizontales Verschieben mit der rechten
Maustaste

— Ein- oder Ausschalten eines Filters durch
Doppelklick auf den Bezugspunkt

Wahrend einer Anderung werden die Werte am
Bezugspunkt eingeblendet. Sollen sie dauerhaft
dort angezeigt werden, am Rand der Grafik auf
das Symbol @ klicken. Zum Ausblenden der
Werte erneut auf das Symbol klicken.

Soll mithilfe der Maus eine Feineinstellung
der Werte erfolgen, am Rand der Grafik auf das
Symbol & klicken. Fir die Ruckkehr zur Grob-
einstellung erneut auf das Symbol klicken.

Fur eine groBere Darstellung der Kurve auf
das Symbol &g klicken. Das erneute Klicken auf
dieses Symbol flhrt dartiber hinaus zur Vollbild-
darstellung. Fur die Ruckkehr zur kleineren Dar-
stellung der Kurve auf das Symbol % klicken.

Uber das Symbol 1 kann die Grafik als Bild-
datei (PNG-Format) gespeichert werden.

6.4.4 Pegelbegrenzung (Limiter)

Der Limiter reduziert die Dynamik und dient zur
schnellen Begrenzung des Signals auf einen
eingestellten Pegel. So lassen sich Signalspit-
zen abschwéchen, um eine héhere Aussteuer-
barkeit und damit eine héhere Durchschnittslaut-
starke zu erreichen.

Fir den Schutz der Lautsprecher vor
Beschadigung durch eine Ubersteuerung der
Endstufen gibt es weitere Limiter im werkskonfi-
gurierten Teil der Signalverarbeitungskette.

1) Mitdem Regler THR (Threshold) den Schwell-
wert einstellen, ab dessen Uberschreitung die
Verstarkung reduziert wird, d. h. den maximal
zulassigen Pegel. Alternativ den Pegel (in
dBu) numerisch in das Feld darunter einge-
ben.

Mit dem Regler REL die Ruckstellzeit (Re-
lease Time) einstellen, d. h. die Anstiegsge-
schwindigkeit der Verstéarkung nach der
Unterschreitung des Schwellwertes bis zum
Erreichen des urspriinglichen Wertes. Alter-
nativ die Anstiegsgeschwindigkeit der Ver-
starkung (in dB/s) numerisch in das Feld
darunter eingeben.

2

~

Wird ein Limiter aktiv, weil der Pegel eines Ein-
gangssignals den eingestellten Schwellwert tber-
schreitet, leuchtet an der Lautsprecherbox die
LED LIMITER (1).

6.4.5 Signalverzégerung

Das Mischsignal aus beiden Eingangen kann
verzgert werden. Dies ist z.B. sinnvoll, wenn
Lautsprecher einen unterschiedlichen Abstand
zu den Hoérern haben. Um die Verzdgerung
durch die Schalllaufzeit auszugleichen, wird das
Signal des naheren Lautsprechers soweit verzo-
gert, dass es nicht vor dem des entfernteren
Lautsprechers beim Horer eintrifft.

Damit die Schalllaufzeit nicht vom Benutzer
berechnet werden muss, kann die Verzégerung
wahlweise nicht nur als Zeit, sondern auch als
Abstand eingegeben werden. Das Programm
rechnet mit einer Schallgeschwindigkeit von
343m/s.

1) Im Hauptfenster (—#MAIN) im Listenfeld Gber
DELAY die Einheit fur die Verzégerung wéah-

len: Zeit (s, ms) oder Abstand (m, mm, feet,
inch, mil).

2) Indas Feld darunter den Wert numerisch ein-
geben oder den Schieberegler unter DELAY
mit der Maus verstellen.

6.4.6 Hochpassfilter (LOW CUT)

Zusétzlich zur Klangkorrektur der beiden Ein-
gangssignale kdénnen aus deren Mischsignal
tiefe Frequenzen herausgefiltert werden.

1) Im Hauptfenster (#MAIN) im Listenfeld Gber
LOW CUT die Einheit fur die Art des Filters
und dessen Steilheit wahlen. Folgende Filter
stehen zur Auswahl:

Butterworth mit 6, 12, 18 oder 24 dB/Oktave
Bessel mit 6, 12, 18 oder 24 dB/Oktave
Linkwitz-Riley mit 12 oder 24 dB/Oktave

In das Feld darunter die Grenzfrequenz
numerisch eingeben oder den Schieberegler
unter LOW CUT mit der Maus verstellen. Am
Linksanschlag des Reglers ist das Filter aus-
geschaltet (Anzeige ,Off).

Der Einsatz des Hochpassfilters wird auch in der
resultierenden Frequenzkurve (weiBe Kurve in
den Frequenzdiagrammen fiur die Eingénge IN-
A und IN-B) bertcksichtigt.

S

6.4.7 Eingange koppeln

Die Bedienelemente der beiden Eingdnge IN-A
und IN-B lassen sich koppeln. Dies vereinfacht
den Einstellvorgang, wenn beide Eingénge iden-
tisch eingestellt werden sollen.

1) Im Hauptfenster auf den Knopf LINK (unter-
halb der Verstarkungsregler) klicken oder in
den Konfigurationsfenstern fir die Eingange
auf den Knopf A+B (rechts unten).

2) Es erscheint ein Hinweis, dass mit diesem
Schritt alle bisherigen Einstellungen des Ein-
gangs IN-A vom Eingang IN-B tbernommen
werden. Die Meldung mit [OK] bestéatigen
oder den Vorgang mit [Cancel] abbrechen.

Wéhrend der Kopplung der Eingénge sind
die Knépfe (LINK, A+B) griin umrandet. Alle
Anderungen fiir Eingang IN-A werden auto-
matisch auch auf Eingang IN-B Ubertragen.
Im Konfigurationsfenster fir IN-B kdnnen
keine Anderungen direkt durchgefihrt wer-
den.

4) Zum Lo6sen der Kopplung erneut auf einen
der Knopfe LINK oder A+B klicken. Die Ein-
génge lassen sich jetzt wieder individuell ein-
stellen.

L

6.5 Konfigurationen verwalten

Die erstellte Konfiguration einer Lautsprecher-
box kann als Preset auf dem Computer oder in
der Lautsprecherbox selbst gespeichert werden.
Flnf Presets mit verschiedener Klangcharakte-
ristik sind vom Werk bereits vorgegeben. Diese
kénnen geladen und als Grundlage flr eigene
Konfigurationen verwendet werden.

Hinweis: Die finf vom Werk vorgegebenen Presets
kénnen nicht gedndert werden. Die dort vorgegebenen
Einstellungen betreffen den werkskonfigurierten Teil
der Signalverarbeitungskette und sind in den Konfigu-
rationsfenstern fiir den Benutzer nicht sichtbar.

6.5.1 Preset laden
Um ein Preset aus dem Speicher der Lautspre-
cherbox zu laden:

1) Im Hauptfenster (#MAIN) im Listenfeld unter
SPEAKER PRESET das gewtlinschte Preset
auswahlen. Auf den ersten funf Speicherplét-
zen befinden sich die vom Werk vorgegebe-
nen Presets. Die Speicherplatze mit hdheren
Nummern kénnen vom Anwender gespei-
cherte Presets enthalten. Unbenutzte Spei-

cherplatze sind als EMPTY PRESET ge-
kennzeichnet.

2) Auf den Knopf LOAD darunter klicken. Wah-
rend des Ladevorgangs wird ein Fenster ein-
geblendet, das den Fortschritt des Vorgangs
anzeigt.

6.5.2 Preset speichern

Um ein Preset in der Lautsprecherbox zu spei-
chern:

1) Im Hauptfenster (=MAIN) in das Feld unter
SPEAKER PRESET den gewlinschten Na-
men flr das Preset eingeben.

Der Name darf aus héchstens 16 Zeichen
bestehen und keine (landesspezifischen)
Sonderzeichen enthalten. Sonst wird eine
Fehlermeldung eingeblendet.

»

Im Listenfeld darunter einen freien Speicher-
platz (EMPTY PRESET) auswéhlen oder
einen schon belegten, wenn das dort gespei-
cherte Preset ersetzt werden soll. Die vom
Werk vorgegebenen Presets auf den ersten
funf Speicherplatzen kénnen nicht Uber-
schrieben werden.

3) Auf den Knopf SAVE darunter klicken. Wéah-
rend des Speichervorgangs wird um den
Knopf herum ein roter Ring anzeigt. Am Ende
des Speichervorgangs erscheint im Listen-
feld der eingegebene Preset-Name.

6.5.3 Preset auf dem Computer speichern
Um ein Preset auf dem Computer zu speichern:

1) Im Hauptfenster (#MAIN) unter PC PRESET
auf den Knopf SAVE klicken. Das Dialog-
fenster ,Choose a preset file“ 6ffnet sich.

Alternativ das Dialogfenster Gber den Menu-
punkt ,File » Save* aufrufen.

2) Den gewinschten Dateinamen eingeben,
den Speicherort wahlen und die Datei spei-
chern. Als Dateiname wird der Preset-Name
mit vorangestellter Speicherplatznummer vor-
geschlagen. Die Dateiendung *.preset wird
dem eingegebenen Namen automatisch
angehangt.

Unabhéngig vom Namen der Datei werden in
der Datei auch Informationen zu dem Namen
des Presets und der Speichplatznummer ge-
speichert.

6.5.4 Preset vom Computer laden
Um ein Preset vom Computer zu laden:

1) Im Hauptfenster (#MAIN) unter PC PRESET
auf den Knopf LOAD klicken. Ein Dialogfens-
ter 6ffnet sich.

Alternativ das Dialogfenster tber den Menu-
punkt ,File » Open® aufrufen.

2) Die gewunschte Datei auswahlen und das
Offnen bestétigen.

Das in der Datei gespeicherte Preset wird in die
Benutzeroberflache geladen und mit dem gespei-
cherten Preset-Namen und der zum Speicher-
zeitpunkt aktuellen Speicherplatznummer ange-
zeigt. Es kann jetzt natlrlich auch auf einen
anderen Speicherplatz im Speicher der Lautspre-
cherbox gespeichert werden (1> Kap. 6.5.2).

6.5.5 Alle Presets auf dem Computer sichern
Um alle Presets aus dem Speicher der Laut-
sprecherbox auf einmal auf dem Computer zu
speichern:

1) Den Menlpunkt ,Hardware #Backup Pre-
sets” aufrufen. Ein Dialogfenster 6ffnet sich.

2) In dem Dialogfenster einen Ordner als Spei-
cherort firr die Dateien auswahlen und besta-
tigen.



3) Wahrend des Speichervorgangs wird ein
Fenster eingeblendet, das den Fortschritt des
Vorgangs anzeigt. Am Ende des Speicher-
vorgangs (Meldung ,Done®) das Fenster liber
die Schaltflache [Close] schlieBen.

Es wird in dem gewahlten Ordner automatisch
ein neuer Ordner angelegt, der die MAC-Num-
mer der betreffenden Lautsprecherbox tragt.
Darin wird ein Ordner angelegt, dessen Name
aus dem Wort ,Backup” sowie aus Datum und
Uhrzeit des Speicherzeitpunktes besteht. In die-
sem Ordner befinden sich dann die einzelnen
Dateien mit den Presets der Lautsprecherbox.

6.5.6 Satz von Presets zuriickspeichern

Um einen auf dem Computer gesicherten Satz
von Presets wieder in den Speicher der Laut-
sprecherbox zu speichern:

1) Den MenUpunkt ,Hardware #»Restore Pre-
sets* aufrufen. Ein Dialogfenster 6ffnet sich.

2) In dem Dialogfenster den gewiinschten Ord-
ner nach MAC-Nummer der Lautsprecherbox
und dem Datum der Sicherung auswahlen
und bestétigen.

Wahrend des Vorgangs wird ein Fenster ein-
geblendet, das den Fortschritt des Vorgangs
anzeigt. Am Ende des Vorgangs (Meldung
,Done“) das Fenster Uber die Schaltflache
[Close] schlieBen.

Es werden nur die Speicherplatze im Speicher
der Lautsprecherbox Uberschrieben, die zum
Zeitpunkt der Sicherung belegt waren.

&L

6.5.7 Factory Presets zuriickspeichern

Um nur die vom Werk vorgegebenen Presets auf
die ersten flinf Speicherplétze der Lautsprecher-
box zu speichern:

1) Den Menlpunkt ,Hardware #Load Factory
Presets® aufrufen. Ein Dialogfenster 6ffnet
sich.

2) In dem Dialogfenster den Ordner ,factory
6ffnen. Dieser befindet sich in dem Installa-
tionsordner des Programms.

3) Je nach Modell der betreffenden Lautspre-
cherbox die entsprechende Datei auswéhlen
und bestatigen (MegaDSPxx.factory).
Beispiel: Fir eine Lautsprecherbox MEGA-DSP08
die Datei ,MegaDSPO08.factory“ wéhlen.
VORSICHT: Die Wahl einer unpassenden
Datei kann im Betrieb im Extremfall zur
Beschéadigung der Lautsprecher fihren.

Waéhrend des Vorgangs wird ein Fenster ein-
geblendet, das den Fortschritt des Vorgangs
anzeigt. Am Ende des Vorgangs (Meldung
,Done“) das Fenster Uber die Schaltflache
[Close] schlieBen.

“«
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6.6 Weitere Einstellungen

6.6.1 Name &ndern

Zur besseren Unterscheidbarkeit kénnen die
Lautsprecherboxen unterschiedlich benannt wer-
den. Zur Anderung des Namens einer Lautspre-
cherbox:

1) Im Hauptfenster (—=MAIN) im Feld unter
UNIT CONNECTION den aktuellen Namen
mit dem neuen Namen Uberschreiben und
mit der Eingabetaste bestatigen.

Der Name darf aus héchstens 16 Zeichen
bestehen und keine (landesspezifischen)
Sonderzeichen enthalten. Sonst wird eine
Fehlermeldung eingeblendet.

2) Der Name wird zur Lautsprecherbox Ubertra-
gen und dort im Display angezeigt. Zudem
wird er in der Liste der Lautsprecherboxen
(Abb. 2, 3) aktualisiert.

6.6.2 Passwort dndern

Um das Passwort fir die Lautsprecherbox zu
andern:

1) Den Menlpunkt ,Hardware #Configure
» Change Password“ aufrufen.

2) Im angezeigten Fenster in das Feld ,Enter
Old Password:“ das bisherige Passwort ein-
geben (vom Werk voreingestellt ist ,mona-
cor").

3) Im nun angezeigten Fenster in das Feld
,Enter New Password:“ das neue Passwort
eingeben.

S

Im anschlieBend angezeigten Fenster in das
Feld ,Confirm New Password:“ das neue
Passwort zur Bestatigung noch einmal einge-
ben.

Wichtig: Das neue Passwort gut merken! Bei
Verlust des Passwortes kann fir die Einstel-
lungen uber einen Computer nicht mehr auf
die Lautsprecherbox zugegriffen werden. Die
verbleibenden Einstellmdglichkeiten an der
Lautsprecherbox héngen von der aktuellen
Einstellung der Zugriffsrechte (1=° Kap. 6.6.6)
ab.

Das neue Passwort wird in der Lautsprecherbox
gespeichert.

6.6.3 Netzwerkeinstellungen éndern

Um die Netzwerkeinstellungen fir die Lautspre-
cherbox zu &ndern:

1) Den Menlpunkt ,Hardware #Configure
» Network Settings“ aufrufen. Das Dialog-
fenster ,Network Configuration (Abb. 7) wird
angezeigt.

n

Im angezeigten Fenster die Option ,Confi-
gure Network Automatically® wéhlen, wenn
die Lautsprecherbox ihre Netzwerkeinstel-
lungen automatisch von einem DHCP-Server
beziehen soll oder, bei fehlendem DHCP-
Server, die Lautsprecherbox selbst die ande-
ren Netzteilnehmer konfigurieren soll. (Die
anderen Netzteilnehmer mussen fir die Kon-
figurierung durch die Lautsprecherbox ent-
sprechend auf den automatischen Bezug der
IP-Adresse eingestellt sein.)

Soll der Lautsprecherbox eine feste IP-
Adresse vorgegeben werden, die Option
,Configure Network Manually” wéhlen.

In das Feld ,IP-Address:” die IP-Adresse,
in das Feld ,Subnet Mask:“ die Teilnetz-
maske des vorgesehenen Netzwerks einge-
ben.

3
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4) Die Eingaben mit [OK] bestatigen oder mit
[Cancel] die urspringliche Einstellung beibe-
halten.

B Neitwork Configuration rzl
‘fou can get IP settings assigned automatically by DHCP iF vour network.
supports this capability, or (if na DHCP server is Found]) the netwark vill
be configured automatically by wour DSP units. Alkernatively, you can
set a fixed IP and subnet mask,

() Configure Metwork Automatically
(%) Configure Metwork Manually:

192.165.1.108
255,255.255.0

1P Address:

Subnet Mask:

@ Netzwerkeinstellungen

6.6.4 Einschalt-Preset festlegen

Um festzulegen, welche Einstellungen fur die
Lautsprecherbox nach dem Einschalten gelten
sollen:

1) Den Menupunkt ,Hardware #Configure
» Power On Preset’ aufrufen. Das Dialog-
fenster ,Choose Preset” (Abb. 8) wird ange-
zeigt.

2) Im Listenfeld des angezeigten Fensters das
Preset wahlen, das jedes Mal nach dem Ein-
schalten der Lautsprecherbox automatisch
geladen werden soll.

Ist erwlinscht, dass die Lautsprecherbox
nach dem Einschalten statt eines Presets
immer die letzten vor dem Ausschalten durch-
gefuhrten Einstellungen bernimmt, hier die
Option ,Last Setting“ wahlen.

3) Die Eingaben mit [OK] bestatigen oder mit
[Cancel] die urspriingliche Einstellung beibe-
halten.

B Choose Preset rg|
Choose the preset that will be loaded upon startup of the
unit, Remember, if vou change any setting, this setting will be
void after power cycling the unit and the original preset will be
loaded again.

|Last Setting L |

[ Ok ][ Caniel ]

Einschalt-Preset

6.6.5 Ruhemodus

Bekommt die Lautsprecherbox flir eine be-
stimmte Zeit an ihrem Eingang kein Signal,
schaltet sie automatisch in den Ruhemodus
(Stand-by). Dabei wird das Display (4) dunkel
und die LED auf der Vorderseite der Lautspre-
cherbox wechselt von Blau nach Rot. Zum Ein-
stellen dieser Zeitspanne:

1) Den Menipunkt ,Hardware »Configure
» Standby Delay“ aufrufen. Das Dialogfenster
,Unit Configuration“ (Abb. 9) wird angezeigt.

2) Hier die Zeit in Minuten eingeben, nach der
die Lautsprecherbox automatisch in den
Ruhemodus wechseln soll (max. 30 Minuten).

Wird der Wert O eingegeben, schaltet die
Lautsprecherbox niemals automatisch in den
Ruhemodus.

3) Die Eingaben mit [OK] bestatigen oder mit
[Cancel] die urspriingliche Einstellung beibe-
halten.

Der Ruhemodus kann auch manuell Gber den
Menupunkt ,Hardware # Go to Standby“ bewirkt
werden.

Die Lautsprecherbox beendet den Ruhemodus
sobald ein Eingangssignal mit ausreichendem
Pegel am Eingang anliegt, wenn eine der beiden
Tasten MENU (2) oder ESC (3) gedriickt oder
wenn der MenUpunkt ,Hardware » Exit Standby“
in einem Konfigurationsfenster aufgerufen wird.

I Unit Configuration

Set the delay time for the Auto-Standby Function (minutes):

1z.0

[ ok H Cancel ]

@ Ruhe-Verzégerung

6.6.6 Optionen bei gesperrter
Lautsprecherbox
Wird eine Lautsprecherbox eingeschaltet oder
die Netzwerkverbindung im Betrieb getrennt,
befindet sie sich im gesperrten Zustand
.Locked“ mit eingeschrankten Bedienmdglich-
keiten. Die Einstellmdglichkeiten fir eine Laut-
sprecherbox im gesperrten Zustand kdnnen fol-
gendermaBen festgelegt werden:

1) Den Menipunkt ,Hardware »Configure
» Locked Rights* aufrufen. Das Dialogfenster
+Access Rights“ (Abb. 10) wird angezeigt.

CR-XC)
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2) Soll eine der aufgefiihrten Optionen im ge-
sperrten Zustand der Lautsprecherbox még-
lich sein, im Ké&stchen davor einen Haken
setzen.

Access Input Channel:
Zugriff auf die Konfiguration der Eingange

Load Presets:
Laden von Presets

Save Presets:
Speichern von Presets

Change Unit Name:
Andern des Geratenamens

Change Unit Configuration:
Andern allgemeiner Einstellungen (Netz-
werk, Ruhemodus, Einschalt-Preset)

3) Die Eingaben mit [OK] bestatigen oder mit
[Cancel] die urspriingliche Einstellung beibe-
halten.

Locked-State Access Rights: Enable access For the end user
AFTER locking the unit {Hardware - Lock Unit ar vis LCD
display) by checking the checkbox per function.

[Jaccess Input Channel

Load Fresets

[ 5ave Presets

] change Unit Mame:

[¥] Change Unit Configuration (Metwork, AutoStandby, Startup Preset etc)

Cancel

6.6.7 Systeminformationen

Uber den Meniipunkt ,Help » About“ lassen sich
Informationen zu der Lautsprecherbox, der
Netzverbindung und zu den Versionen der Firm-
ware der Lautsprecherbox, der Schnittstellen-
Firmware und des Computerprogramms anzei-
gen (Abb. 11). Ist eine neuere Firmware-Version
im Computerprogramm verfligbar, wird dies an-
gezeigt (Update Available). In diesem Fall sollte
ein Update durchgefiihrt werden (15> Kap. 6.3.4).
Ist die Firmware oder Interface-Firmware aktuell,
wird dies mit (OK) hinter der Versionsnummer
angezeigt.

B About X

it InFormation:
Mame: mega-dsp 10
Serial Number: 39976
Connected By: 192.168.1,108
MAC Address: BS:96:74:00:05: 7C
Firrmmare Version: 3.1.6 (0K)
Intetface Yersion: 2,7.0 (0K}

Application Infarmation:
Application Yersion: 3.1.6
Build: 103669

Copyright () Monacar

Sperroptionen

7 Technische Daten

@ Systeminformationen

Uber den Menuipunkt ,Hardware # Status Details*
lassen sich aufgetretene Fehler anzeigen.

6.6.8 Konfigurationsfenster schlieBen

Uber den Meniipunkt ,File »Quit* kénnen die
Fenster fir die Konfiguration einer Lautspre-
cherbox geschlossen werden. Solange die Laut-
sprecherbox nicht ausgeschaltet oder vom Netz
getrennt wird, muss das Passwort bei einem
erneuten Aufruf dieser Lautsprecherbox tiber die
Schaltflache [>>] in der Liste (Abb. 2, 3) nicht
noch einmal eingegeben werden.

Soll dennoch eine erneute Eingabe des
Passwortes erzwungen werden, den MenUpunkt
,Hardware #Lock Unit“ aufrufen. Es erscheint
ein Hinweis, dass anschlieBend nur ein Zugriff
auf die Einstellungen der Lautsprecherbox tber
das richtige Passwort maglich ist.

Modell MEGA-DSP08 MEGA-DSP10 MEGA-DSP12 MEGA-DSP15
Verstarkerleistung (Sinusleistung)

Hochton 100W

Tiefton 500 W
Frequenzbereich (-6 dB) 60—-20000 Hz 55—-20000 Hz 45-20000 Hz 40-20000 Hz
Max. Nennschalldruck 116dB 119dB 121dB 123dB
Basslautsprecher @ 20cm (8”) @ 25cm (10”) @30cm (12”) & 38cm (15”)
Hochtonlautsprecher dynamischer Hornhochténer, & 25,4 mm (1”)

Schwingspule & 44 mm
Nenneingangsspannung

LINE 1V

AUX 1V

MIC 50mV
Max. Eingangsspannung

LINE 7V

AUX 5V

MIC 850 mV
Eingangsimpedanz

LINE 16 kQ

AUX 8kQ

MIC 2kQ
Richtcharakteristik -6 dB (H x V) 90° x 60°
Einsatztemperatur 0-40°C
Stromversorgung 230 V~/50 Hz 230 V~/50 Hz 230V~/50 Hz 230 V~/50 Hz
max. Leistungsaufnahme 320 VA 360 VA 580 VA 790 VA
Abmessungen (B x H x T) 290 x 480 x 313 mm 320 x 504 x 345 mm 350 x 612 x 383 mm 416 x 678 x 454 mm
Gewicht 15,5kg 18kg 19kg 25,5kg

Diese Bedienungsanleitung ist urheberrechtlich fir MONACOR® INTERNATIONAL GmbH & Co. KG geschiitzt.

Eine Reproduktion fiir eigene kommerzielle Zwecke — auch auszugsweise — ist untersagt.

Anderungen vorbehalten.
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We wish you much pleasure with your new “img
Stage Line” unit. Please read these operating
instructions carefully prior to operating the unit.
Thus, you will get to know all functions of the
unit, operating errors will be prevented, and
yourself and the unit will be protected against
any damage caused by improper use. Please
keep the operating instructions for later use.
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1 Operating Elements
and Connections

1 Status LEDs:

POWER Power LED

SIGNAL A Signal A after gain control
SIGNAL B  Signal B after gain control
LIMITER Level limiting active
PROTECT Protective circuit active

2 Button MENU to select a menu item and to
confirm user input

3 Button ESC to exit a menu and to cancel a
function

4 LC display

5 Knob MASTER VOLUME to adjust the vol-
ume of input channel A (gain control)

6 Knob SELECT/ENTER to adjust the volume
of input channel B (gain control) and to select
a preset and change values in the menu

7 Status LEDs LINK/ACT for the Ethernet con-
nection (connection and activity indication)

8 RJ45 jack for the Ethernet connection to con-
figure the signal processor by means of a
computer

9 Selector switch for the input sensitivity of
input LINE A/MIC (10)
MIC = microphone
LINE = line-level signal source
The LED indicator next to the switch lights up
when MIC is selected

10 Input LINE A/MIC as combined XLR/6.3 mm
jack, and an XLR connection underneath
to transmit the input signal, e.g. to another
speaker system

11 Input LINE B as combined XLR/6.3 mm jack,
and an XLR connection underneath to trans-
mit the input signal, e. g. to another speaker
system

12 Input AUX as RCA jacks for input channel B

13 XLR output MIX OUT with mixed signal of the
inputs A and B to be transmitted, e.g. to
another speaker system

14 Cooling fins
15 Power switch

16 PowerCon® mains output jack AC LINK to
connect another speaker system of the
MEGA-DSP series (=" chapter 4.5)

17 PowerCon® mains input jack AC INPUT for
connection to a socket (230 V~/50 Hz)

2 Safety Notes

This unit corresponds to all relevant directives of
the EU and is therefore marked with C€.

WARNING The unit uses dangerous mains
voltage (230 V~). Leave servicing
to skilled personnel only and do
not insert anything into the air
vents! Inexpert handling of the unit
may result in electric shock.

Please observe the following items in any case:

® The unit is suitable for indoor use only. Protect
it against dripping water and splash water,
high air humidity and heat (admissible ambi-
ent temperature range: 0—40 °C).

® Do not place any vessel filled with liquid on the
unit, e. g. a drinking glass.

® The heat generated inside the unit must be
dissipated by air circulation; never cover the
air vents of the housing and the cooling fins
(14). Never position the rear side of the
speaker system directly against a wall; always
make sure the distance is sufficient.

® Do not operate the unit and immediately dis-

connect the mains plug from the socket

1. if the unit or the mains cable is visibly dam-
aged,

2. if a defect might have occurred after the unit
was dropped or suffered a similar accident,

3. if malfunctions occur.

In any case the unit must be repaired by

skilled personnel.

® Never pull the mains cable to disconnect the
mains plug from the socket; always seize the
plug.

® For cleaning only use a dry, soft cloth; never
use water or chemicals.

® No guarantee claims for the unit and no liabil-
ity for any resulting personal damage or mate-
rial damage will be accepted if the unit is used
for other purposes than originally intended, if it
is not correctly connected or operated, or if it
is not repaired in an expert way.

)¢

If the unit is to be put out of operation
definitively, take it to a local recycling
plant for a disposal which is not harmful
to the environment.

3 Applications

The speaker systems of the MEGA DSP series
are high-performance active speaker systems in
rugged wooden housings. They are suitable for
a wide range of applications, e. g. for dances, for
smaller stages or as monitor speakers for bands.
The speakers are designed as 2-way systems.
Each of them is provided with a separate ampli-
fier for the bass speaker and tweeter ranges.
The amplifiers are equipped with protective cir-
cuits against overload and overheating.

The speaker systems include two balanced
signal inputs; one of them can be switched to

microphone sensitivity. For the other input,
unbalanced connections are available. Addi-
tional signal outputs allow, for example, for the
connection of further active speaker systems.

The digital signal processor (DSP) is the
core component of the MEGA-DSP series, offer-
ing numerous options for changing the sound,
readjusting the delay time and limiting the
dynamic range. The DSP can be remotely con-
trolled via a computer network. Various configu-
rations may be saved as presets in the speaker
system and can thus be made available for
standalone operations.

4 Setup and Connection

Place the speaker system on a firm ground, e. g.
on the stage or on a table and align it to the ears
of the listeners. Due to its bevelled housing, the
speaker system can be used as a stage monitor,
radiating diagonally upwards. If a microphone is
to be used, do not direct the speaker towards the
microphone and make sure that the distance
between the speaker system and the micro-
phone is sufficient; otherwise, an acoustic feed-
back (loud howling) may occur.

Alternatively, use the stand sleeve located
on the lower side of the speaker system to place
the speaker onto a standard speaker stand with
a tube diameter of 35 mm (e.g. from the PAST
series of the “img Stage Line” product range).

To support additional mounting options, the
housing is provided with numerous M8 threaded
jacks where, for example, mounting brackets
(MHB-.../MVB-...) or the ring bolt delivered with
the speaker system can be fastened. To use the
M8 threaded jacks, remove the corresponding
cover screws (hexagon socket screws).

When positioning the speaker system,
always make sure that air is able to flow freely
through the cooling fins (14) on the rear side of
the system to provide sufficient cooling.

WARNING Installations which are not made in
an expert way are a hazard, espe-
cially if systems are suspended
(flown) above persons. Therefore,
the installation must only be made
by expert personnel familiar with
the valid standards and safety reg-
ulations.
The installation, especially the stability of the
mounting connections, must be checked at reg-
ular intervals.

4.1 Turning the tweeter

If the speaker system is to be mainly operated in
a horizontal position (e. g. as a floor monitor), the
tweeter may be turned by 90° for a wider radia-
tion of the high frequencies. For this purpose,
remove the metal front (lateral screws), remove
the four screws of the tweeter and retighten the
tweeter in a position turned counterclockwise
by 90°.

13
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Prior to connecting the speaker system or
changing existing connections, switch off the
speaker system and the units to be connected.

For the connections of a line-level signal
source (e.g. CD player, mixer output), the fol-
lowing options are available:

— For balanced signals, the combined XLR/
6.3mm jacks LINEA/MIC (10) and LINEB
(11) [the contact configuration is printed on
the unit, see figure].

— For unbalanced signals, the RCA jacks AUX
(12) are suited. If the two RCA jacks or if the
RCA jacks and the jack LINEB (11) are used
together, the input signals will be mixed, cre-
ating a mono signal when a stereo signal
source is connected. For a stereophonic
sound reproduction, connect each stereo
channel to a separate speaker system.

An unbalanced mono signal can also be
connected to the jack LINEA/MIC (10) or
LINEB (11) by means of a 2-pole plug.

A microphone can be connected to the com-
bined XLR/6.3mm jack LINE A/MIC (10). The
jack is provided for balanced signals for both
plug types.

A microphone with an unbalanced output
signal can be connected to the jack by means of
a 2-pole plug.

To remove an XLR plug from the jack, press the
PUSH lever.

4.2.1 Selecting the input sensitivity

If a microphone is connected to the input LINE A/
MIC (10), switch the selector switch LINE/MIC
(9) to the position MIC to increase the input sen-
sitivity. The LED indicator next to the selector
switch will light up. To connect a line-level signal
source, switch the selector switch to the position
LINE.

4.3 Signal outputs

The XLR jacks beneath the input jacks (10 and
11) are provided to transmit an input signal to
additional speaker systems or to a recorder. The
mixed signals of the inputs LINE A/MIC, LINEB
and AUX are additionally present at the jack MIX
OUT (13).

4.4 Computer

To operate the speaker system by remote-control
or to configure the presets, connect the speaker
system to a single computer or to a computer net-
work, using the jack ETHERNET (8) [1=° chap-
ter 6].

4.5 Mains connection
To provide power to the speaker system, con-
nect the speaker system to the 230V mains,
using the PowerCon® mains input jack AC
INPUT (17). No mains cable is supplied with the
speaker system. A mains cable equipped with a
PowerCon® plug and an earthed plug (e.g.
AAC-115P from “img Stage Line”) can be used.
Use the PowerCon® mains output jack AC
LINK (16) to connect an additional speaker sys-
tem. Thus, a maximum of four speaker systems
of the MEGA-DSP series can be connected with
each other.
Note: A PowerCon® plug must not be under load or
voltage when it is connected or disconnected. There-
fore, always first establish the PowerCon® connection
and then the mains connection, and always disconnect
the mains connection prior to the PowerCon® connec-
tion.

5 Operation

CAUTION: The volume is digitally adjusted by
means of the two knobs (5, 6) or by remote con-
trol via the network, and cannot be changed or
read before the unit is switched on. Therefore,
the signal sources should be switched off when
the initial adjustment of the unit at switch-on is
not known.

Use the Power switch (15) to switch on the
speaker system. The LED POWER (1) and the
LED on the front panel of the speaker system
light up. The upper line of the display (4) shows
the name of the speaker system; the lower line
shows the name of the current preset.

Once the connection to the control program
on a computer has been established via the net-
work, the lower line of the display shows
Etbure -t.iwe and it is no longer possi-
ble to make operations at the speaker system.

5.1 Operation without computer

For standalone operation, the speaker system

may not be connected (via a network) to a com-

puter running the control program.

1) Use the control “MASTER VOLUME” (5) to
adjust the volume for the input LINE A/MIC
(10).

2) Use the control “SELECT/ENTER” (6) to
adjust the volume for the inputs LINE B (11)
and AUX (12).

The gain value adjusted (in dB) is shown on the

display (4), e.g.:

T e

If both input channels are linked due to a preset,
the upper line will show the following:

Im HE
In this case, each of the two controls will always
adjust the volume of both channels.

CAUTION Never adjust the amplifier to a

2 very high volume. Permanent high

Gain

volumes may damage your hear-
ing! Your ear will get accustomed
to high volumes which do not
seem to be that high after some
time. Therefore, do not further
increase a high volume after get-
ting used to it.

Functions of the status LEDs (1):

— The LEDs SIGNAL A and SIGNAL B will light
up when a signal is present at the correspond-
ing input and when the gain adjustment
selected is not too low.

— The LED LIMITER will light up as soon as
level limiting for an input channel is active.

— The LED PROTECT will light up as soon as
the protective circuit responds, and will light
up briefly each time the unit is switched on or
off.

Note: All the adjustments made will be kept after

switch-off, if the switch-on settings “Power on Preset”

for the speaker system have been set to “Last Setting”
(1= chapter 6.6.4).

5.1.1

Note: The factory settings provide this function to all
users; however, the function can be locked by means of
the setting menus (E=5° chapter 6.6.6).

To call up a preset:

1) Press the button MENU (2) to show the fol-
lowing on the display (4):1 followed by
the preset number in the first line, and the

Calling up presets

name of the preset most recently selected in
the second line.

The first five storage spaces are occupied

by predefined presets; the remaining storage
spaces can be configured as desired.
Turn the knob SELECT/ENTER (6) to select
the desired preset; then press the knob
SELECT/ENTER to confirm. The following
message will appear on the display:

n

Loz

]

Turn the knob SELECT/ENTER to the right to
load the preset. The following message will
appear on the display:

&L

4) Press the knob SELECT/ENTER. The preset
is being loaded. During loading, the name of
the preset is followed by .

Pressing the button ESC (3) in the above steps
or waiting for more than one minute will cancel
the operation.

5.1.2 Showing system information
To show system information:

1) Press the button MENU (2) repeatedly until
P L TR M . or M

appears on the dlsplay (4).

2) Turn the knob SELECT/ENTER (6) to show
more information.

Pressing the button ESC (3) in the above steps
or waiting for more than one minute will cancel
the operation.

5.1.3 Deactivating a lock

Each time the speaker system is switched on,
the speaker system is in a locked state providing
only a limited range of operating options. The
options available after switch-on can be defined
on the computer in the settings of the speaker
system (1= chapter 6.6.6). Entering the pass-
word for the speaker system will deactivate the
lock. The password is factory-set to “monacor”
and can individually be changed for each
speaker system (1=° chapter 6.6.2 or chapter
5.1.4).

1) Press the button MENU (2) repeatedly until
=1 appears on the display

2) Turn the knob SELECT/ENTER (6) to se-
lect the option Lirilozkecd; then press the

knob SELECT/ENTER to confirm.
P 1 is shown on the display.

Turn the knob SELECT/ENTER to select the
first password character for the speaker sys-
tem; then press the knob SELECT/ENTER to
go to the next character position.

L

4) Proceed in the same way to enter the remain-
ing password characters; however, do not
press the knob after the last character has
been selected. To correct a character, use
the button ESC (3) to return to the previous
character position.

5) When the password is complete, press the
button MENU to confirm.

5.1.4 Locking unit, changing password
To lock the unit while in operation and, if re-
quired, change the password at the same time:

1) Press the button MENU (2) repeatedly until
i is shown on the display




2) Turn the knob SELECT/ENTER (6) to select
the option : Loonkecd then
press the knob SELECT/ENTER to confirm.
The first line of the display shows Hiet.
Fazsworod, and the second line shows the

current password of the speaker system.

&L

To leave the password unchanged, press the
button MENU and continue with step 6.

To assign a new password, overwrite the
password shown on the display. To do so,
turn the knob SELECT/ENTER to select the
first character of the new password, and then
press the knob SELECT/ENTER to go to the
next character position.

Proceed in the same way to enter the remain-
ing password characters; however, do not
press the knob after the last character has
been selected. To correct a character, use
the button ESC (3) to return to the previous
character position.

The maximum length of the password is
8 characters. If the new password is shorter
than the old one, overwrite the old characters
at the end of the password with space char-
acters.

=
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When the password is complete, press the
button MENU to confirm. The display i
Firm F il appears, asking you to
confirm the password again.

2

Press the button MENU to confirm, or press
the button ESC to correct the password.

Important: Make sure to remember the new
password! If the password gets lost, it will not
be possible to access the settings of the
speaker system via the computer. The setting
options available at the speaker system
depend on the current access right settings
(1= chapter 6.6.6).

6 Remote Control by Means
of a Computer

The speaker system includes a digital signal
processor (DSP) which on the one hand splits
the signal to the bass speaker and the tweeter
and on the other hand offers a wide range of
options for equalizing the frequency response,
readjusting the delay time, and limiting the
dynamic range. The DSP is factory-configured
and ready to use. Five presets with different
sound characteristics are available. The com-
puter software delivered with the speaker system
allows users to define their own settings, e. g. for
adapting the system to the room acoustics. By
means of the Ethernet interface (8), the speaker
system can be connected to a single computer, a
local computer network or, e.g. via a router, to
larger computer networks (Internet). Network
technology expertise is indispensable for the
correct installation of the connection.

Note: A direct connection of the speaker system to the
computer may require the use of a crossover cable or a
corresponding adapter.

6.1 Installing the PC software

The installation of the control program supplied
with the speaker system requires a computer
equipped with the Windows XP operating sys-
tem with Service Pack 2 or a later Windows ver-
sion, or Mac OS X version 10.5.8 or later and an
Ethernet interface. The screen resolution should
be at least 1024 x 768 pixels. To install the
PC software, start the installation program
“Setup.exe” or “Setup [...].msi” or “[...] Con-
troller.mpkg” (for Mac OS X) on the CD supplied
and follow the instructions of the installation pro-
gram.

Windows is a registered trademark of Microsoft Corporation in the United

States and other countries. Mac OS is a registered trademark of Apple Com-
puter, Inc. in the United States and other countries.

6.2 Establishing a network connection

As per its factory settings, the speaker system
automatically obtains network settings from a
DCHP server in an existing network. If there is
no DHCP server in the network connected, the
speaker system will automatically assume the
role of a DHCP server and will allocate an IP
address to each of the other network members
that are defined to automatically obtain network
settings.

If only specific IP addresses are to be used,
a particular IP address can be manually as-
signed to the speaker system (1= chapter
6.6.3).

When in standalone operation, the most
recently set IP address of a speaker system can
be shown, using the menu (=" chapter 5.1.2).
Note: The speaker system can only be configured by
means of the program when the computer and the
speaker system belong to the same sub-network. If
they do not, it may be reasonable to first only connect
the speaker system to a computer that automatically
obtains its network settings from the speaker system.
This connection can then be used to adapt the network
settings of the speaker system to the settings of the
designated network.

6.3 Control program
1) On the computer, call up the control program
“IMG Stage Line DSP Controller”.

A window appears, asking the user to
enter the password for starting the program.
The pre-defined password is “monacor”. The
user can change this password later.

2) Enter the password (without the inverted
commas), observing the spelling.

If the password is not correctly entered,
the message “Invalid password!” will be
shown. Confirm this message and re-enter
the password.

The overview window (fig. 2) appears, providing
a list of all the speaker systems connected.

In the upper row “All Units”, the information
given in parentheses indicates the number of
speaker systems that are currently online, i.e.
actively connected with the computer.

MG Stage Line DSP Controller
Filz  Tools Help

Info Marne

B  alunis 1 units online)

N @ | Testlautsprecher 00
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@ Overview window

rkup...

The following rows provide functions and
information with regard to the speaker systems.
Each row includes the following columns:

Info

Button [M] to mute the speaker system. The but-
ton appears in red as long as the speaker sys-
tem is muted. To reactivate the sound, click the
button again. To mute all the speaker systems
connected, click the button M] in the row “All
Units”.

Button [L] to locate and identify a speaker sys-
tem. When the button has been clicked, the but-
ton as well as the status LEDs (1) on the rear
panel of the corresponding speaker system flash
for some seconds.

The colour field () indicates the connection sta-
tus. Itis green for units connected, and yellow for
connections interrupted. When a new connec-
tion is established at switch-on, an additional row
“Startup...” with an orange-coloured field ap-
pears at the end of the list.

The two vertical bars next to the coloured field
are a simple level indication of the bass speaker
and tweeter for the speaker system.

Name

Shows the name of the speaker system. The
predefined name of the speaker system may be
changed later (1= chapter 6.6.1) for easier iden-
tification.

Reference

Shows the hardware address (MAC address) of
the network interface of the speaker system.
This address can be used to clearly identify a
speaker system.

Address

Shows the IP address of a speaker system con-
nected. If the connection is interrupted, “Offline”
will be shown instead of the IP address.

Group

The list box field shows the group the speaker
system currently belongs to. The list box can be
used to assign the speaker to another group
(group functions 15 chapter 6.3.1). The option
“Not grouped” indicates that the speaker system
is not assigned to any group.

Launch

If a speaker system is “online”, the button [>>]
can be used to call up the corresponding config-
uration window (fig. 5). To hide the list of speaker
systems, click the button [Close]; to show the list,
click the button [Open].

=SS
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6.3.1 Unit groups

Multiple speaker systems may be grouped so
that they can be controlled (e. g. muted) simulta-
neously. Changes made to the settings of a
speaker system in a group will automatically
apply to all speaker systems of this group. It is
always possible to assign a speaker system to
another group.

6.3.1.1 Creating a new group
1) To create a new group, call up the menu item
“Tools # New Group”.

2) In the window displayed, enter the desired
group name in the field “Enter the name of the
new group:”.

At the end of the list of speaker systems,
an additional row for the group appears (row
“Group: ...").

3) In each row of the speaker system to be
included in the group, select the new group
from the list in the column “Group”.

This procedure can also be used at any
time to remove a speaker system from a
group (select ,Not Grouped®) or to assign a
speaker box to another group.

The row “Group: ...” indicates the number
of speaker systems (members) that currently
belong to the group.

4) Use the button [Open] at the end of the row
“Group: ...” to show a list of all group mem-
bers beneath the row; use the button [Close]
to hide the list (1= fig. 3 —the list includes two
members).

6.3.1.2 Deleting a group

To delete a group, click the button [Delete]
(= fig. 3) in the row of this group. A confirmation
box appears, asking you to confirm the deletion.
If the group to be deleted includes speaker sys-
tems, an additional note will let you know that the
entry “Not Grouped” will be assigned to the
speaker systems.

6.3.2 Changing the program password
To change the password for starting the pro-
gram:

1) Call up the menu item ,Tools » Change Soft-
ware Password”.

2) In the window displayed, enter the current
password in the field “Enter Old Password:”
(the pre-defined password is “monacor”).

3) Inthe window displayed, enter the new pass-
word in the field “Enter New Password:”.

4) In the window displayed, re-enter the pass-

word in the field “Confirm New Password:”.
Make sure to remember the password!
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6.3.3 Demo mode

If no speaker system is connected to the com-
puter, a virtual speaker system can be created
for demonstration purposes. To do so, call up the
menu item “Tools # Enter Demo Mode”.

In the list, a virtual speaker system named
“Mega DSP” with the designation “DEMO...”
in the field “Reference” is shown. As with real
speakers, the configuration window can be
called up by means of the button [>>] (1= fig. 5).

To remove the virtual speaker system from
the list, call up the menu item “Tools #Leave
Demo Mode”.

6.3.4 Firmware update

To ensure a smooth communication between
the control program and the speaker system,
both units must be equipped with matching
firmware versions. If the control program is
newer, the firmware (operating system) of the
speaker system may be updated by means of
the control program. With this update, all settings
in the speaker system will get lost. To keep the
settings, save them on the computer (i=° chap-
ter 6.5.5) before starting the update.

Note: Firmware updates are performed at your own
risk. After a firmware update, the functions of the unit

may differ from those described in this instruction
manual.

CAUTION: Switch off the signal sources or
reduce their output level so that the volume is not
unexpectedly high after the settings have been
reset.

To update the firmware of a speaker system, call
up the menu item “Tools » Enable Update”. On
the right-hand side of the list, the column
“Update” appears.

1) In the row of the speaker system to be
updated, click the button [>>] in the column
“Update”.

2) A message appears which informs the user
that it is not allowed to switch off the speaker
system or to interrupt the connection during
the multi-step update process. If the update
fails, it must be started again.

Click the button [OK] to start the update, or
click [Cancel] to cancel the update.

Upon completion of the update, another mes-
sage appears. Confirm this message.

If the program determines that the firm-
ware of the speaker system is up to date, the
settings will not be reset to the factory set-
tings.

To reset the model-specific factory settings
(preset 1-5), call up the configuration win-
dow of the speaker system and select the

L
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function “Hardware #Load Factory Presets”
(1= chapter 6.5.7).

To hide the column “Update” in the list, call up
the menu item “Tools # Disable Update”.

Note: Resetting to the factory settings will also affect
the network settings and the password of the speaker
system; i. e. it may initially not be possible to access the
speaker system via the computer.

6.3.5 BGM player
Use the menu item “Tools # BGM Player » Open
File/Open Directory” to call up a small utility pro-
gram for playing audio files on the computer.
“Open File” will play a single file; “Open Direc-
tory” will play all files included in the directory.
To play audio files on a speaker system,
connect the audio output of the computer to the
audio input (12) of the speaker system to be
used.

6.3.6 Exiting the program

To exit the program, call up the menu item “File
» Quit” or close the program window.

6.4 Configuring the speaker

CAUTION!
Combined with the control program, the signal
processor is an effective tool for making very
detailed but also major changes to the trans-
mission properties of the speaker system.
Therefore, each modification to the param-
eters should be performed with care and
expertise. At the worst, extreme changes to the
settings may damage the speaker system.

1) To configure a speaker system, click the but-
ton [>>] in the column “Launch” of the list
(1= figs. 2, 3).

2) A dialog window appears. The name of the
corresponding speaker system and its MAC
address are shown in the list field.

If desired, select another speaker system.

L

In the field beneath “Password”, enter the
password for the speaker system selected.
The password is factory-set to “monacor” and
can individually be changed for each speaker
system (1=5° chapter 6.6.2 or chapter 5.1.4).

4) The main window (fig. 5) for the speaker sys-
tem selected appears. The colour field on the
left-hand side, next to UNIT CONNECTION,
indicates the connection status of the
speaker system. When the colour field is
green, a data connection is established. A
red colour field indicates that the connection
is interrupted and that it is not possible to
modify settings; if the user tries to make
changes, an error message will appear.

Click the buttons [IN-A] and [IN-B] to
switch to the configuration windows of the
two input signal paths (fig. 6). Click the button
[ MAIN ] to return to the main window.

Any settings changed on the screen are instantly
transferred to the speaker system, provided that
a data connection exists. The settings can be
saved as presets on the computer (15> chapter
6.5.3) or in the speaker system (1= chapter
6.5.2). In addition, it is possible to define if the
speaker system, when being switched on, is to
load a specific preset or the state it was in when
switched off (1=° chapter 6.6.4).

Figure 4 shows a block diagram of the path
a signal takes through the amplifier system.
Starting with the two inputs on the left-hand side,
the signals, after A/D conversion, pass the input
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amplifier (GAIN), the 10-band sound adjustment
(EQ) and the level limiter (LIMITER) before they
are mixed. For the resulting mixed signal, a
delay (DELAY) and a high pass filter (LOW CUT)
can be set. The user can configure the signal
path described up to this point and highlighted by
a frame in the block diagram. The following sig-
nal-processing steps are factory-defined: fre-
quency split to the two output branches HF and
LF and for each of them sound correction, signal
delay, level limiting, D/A conversion. The LF sig-
nal is transmitted to the amplifier (class D) of the
bass speaker; the HF signal is transmitted to the
amplifier (class AB) of the tweeter.

% mega-dsp10 (B8:96:74:00:05:7C)

6.4.1 Setting the gain

The gain can be separately set for both input sig-
nals. To do so, use the slider INPUT CONTROL
in the main window (fig. 5) or the slider GAIN in
the configuration window of the respective input
IN-A (fig. 6) or IN-B. Alternatively, instead of set-
ting the value by means of the sliders, enter the
numeric value (in dB) beneath the sliders.

Next to each of the sliders, a scale indicating
the selected input level is provided. The resulting
levels of the tweeter (HF) and the bass speaker
(LF) are indicated on the right-hand side of the
main window.
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6.4.2 Muting the input

To mute an input, click the button MUTE beneath
the corresponding gain slider in the main window
or in the configuration window of the respective
input IN-A or IN-B. While the input is muted, the
button MUTE has a red contour. To switch on the
sound, click the button MUTE again.

6.4.3 Sound correction

In the lower section of the configuration window
for IN-A and IN-B, 10 parametric equalizers (fil-
ters) are provided. Combine these filters to per-
form highly complex sound corrections (e. g. to
adapt the system to the room acoustics).

1) Click the button ON at the beginning of a filter
row to switch a filter on (button has a green
contour) or off.

2) Inthe field TYPE, select the filter characteris-
tic: Bell, Notch, AllPass, Low Shelf, High
Shelf, Band Pass, High Pass or Low Pass.

3) In the field FREQ., enter the filter frequency
desired.

4) In the field Q, enter the quality factor desired
or, as an alternative, the relative bandwidth
BW. Click [Q] or [BW] to switch between
these two parameters.

5) In the field GAIN, enter the amplification fac-
tor desired. The availability of this parameter
depends on the filter characteristic selected.

6.4.3.1 Frequency response

The effects of the filter settings on the amplitude
frequency response are represented by means
of curves. Each filter is assigned a reference
point (small square with number) and a coloured
frequency curve. A white curve shows the fre-
quency response resulting from all active filters.

Some of the filter parameters can also be set
graphically. To do so, move the appropriate ref-
erence point, using the mouse.

— To change the frequency, move the mouse
horizontally

— To change the gain, move the mouse verti-
cally

— To change the quality factor/bandwidth,
press the right mouse button and move the
mouse horizontally

— To switch a filter on or off, double-click the
reference point

While being changed, the values are shown at
the reference point. To show them permanently
at the reference point, click the icon on the
edge of the graphic. To hide the values, click the
icon again.

For fine adjustment by means of the mouse,
click the icon & on the edge of the graphic. To
return to the rough adjustment, click the icon
again.

For a larger display of the curve, click the
icon Bg. For a full-screen display, click the icon
again. To return to a small curve display, click
the icon %.

To save the graphic as an image (png for-
mat), click the icon EX.
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@@ 6.4.4 Limiter
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The limiter reduces the dynamic range and
allows the user to quickly limit the signal to an
adjusted level. Thus, signal peaks can be atten-
uated in order to obtain a higher gain setting and
consequently a higher average volume.

Additional limiters in the factory-set part of
the signal-processing chain are provided to pro-
tect the speakers against damage due to ampli-
fier overload.

1) Use the slider THR (threshold) to set the
threshold value. If this value is exceeded, the
amplification will be reduced. Alternatively,
instead of setting the value by means of the
slider, enter the numeric value (in dBu) in the
field beneath the slider.

Use the slider REL to set the release time, i.e.
the speed by which the amplification is to
increase until it reaches its original value after
the signal level has fallen below the threshold
value. Alternatively, instead of setting the
value by means of the slider, enter the
numeric value (in dB/s) in the field beneath
the slider.

2

~

If a limiter is activated because the level of an
input signal has exceeded the threshold defined,
the LED LIMITER (1) on the speaker system will
light up.

6.4.5 Signal delay

The mixed signal of the two inputs can be
delayed. This is reasonable, e. g. when speakers
are not equally distant from the listener. To bal-
ance the different sound delay times that arise
from the different distances, the signal of the
nearer speaker system is delayed so that it does
not reach the listener earlier than the sound of
the more distant speaker system.

The user does not have to calculate the
sound delay time, i. e. the user can enter the dis-
tance instead of the delay time. The calculations
performed by the system are based on a speed-
of-sound value of 343 m/s.

1) In the main window (—=MAIN), from the list
field above DELAY, select the unit for the
delay: time (s, ms) or distance (m, mm, feet,
inch, mil).

2) Inthe field beneath, enter a numeric value or,
as an alternative, move the slider beneath
DELAY, using the mouse.

6.4.6 High pass filter (LOW CUT)

In addition to the sound correction of the two
input signals, the low frequency of their mixed
signal can be filtered.

1) In the main window (—MAIN), from the list
field above LOW CUT, select the unit for the
filter type and its slope. The following filters
are available:

Butterworth with 6, 12, 18 or 24 dB/octave
Bessel with 6, 12, 18 or 24 dB/octave
Linkwitz-Riley with 12 or 24 dB/octave

In the field beneath, enter a numeric value for
the crossover frequency or, as an alternative,
move the slider beneath LOW CUT, using the
mouse. To switch off the filter (“Off” shown in
the field), move the slider to the very left.
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The usage of a high pass filter is reflected in the
resulting frequency curve (white curve in the fre-
quency diagrams for the inputs IN-A and IN-B).

6.4.7 Linking inputs

The controls of the two inputs IN-A and IN-B can
be linked, making the setting procedure much
easier when both inputs are to be set identically.

1) In the main window, click the button LINK
(beneath the gain sliders), or in the configu-
ration windows of the inputs, click the button
A+B (right-hand side at the bottom).

A note appears informing the user that this
step will cause input IN-B to adopt all settings
of IN-A that have so far been defined. Click
[OK] to confirm; click [Cancel] to cancel.

D
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While the inputs are being linked, the buttons
(LINK, A+B) have a green contour. All
changes made to input IN-A are automati-
cally transferred to input IN-B. It is not possi-
ble anymore to make any direct changes in
the configuration window of IN-B.

To dissolve the link, click on the button LINK
or A+B again. Then, the inputs can be indi-
vidually set again.

K

6.5 Managing configurations

The speaker configuration created can be saved
as a preset on the computer or in the actual
speaker system. Five pre-defined factory pre-
sets with various sound characteristics are avail-
able. They may be loaded and used as a basis
for user-defined configurations.

Note: The five pre-defined factory presets cannot be
changed. The settings of these factory presets apply to
the factory-configured part of the signal-processing
chain and are not visible in the configuration menus.

6.5.1 Loading a preset

To load a preset from the storage of the speaker
system:

1) In the main window (—MAIN), from the list
field beneath SPEAKER PRESET, select the
preset desired. The first five storage spaces
are occupied by the factory-defined presets.
The following storage spaces can be used
for user-defined presets. Unused storage
spaces are indicated by EMPTY PRESET.

Beneath the list field, click the button LOAD.
While the preset is being loaded, a window is
shown indicating the loading progress.

D

6.5.2 Saving a preset
To save a preset in the speaker system:

1) In the main window (—MAIN), in the field
beneath SPEAKER PRESET, enter the
name desired of the preset.

The maximum length of the name is
16 characters, and the name may not include
(language-specific) special characters. Oth-
erwise, an error message will be displayed.

D

From the list beneath the name field, select a
free storage space (EMPTY PRESET) or, if
an existing preset is to be replaced, an occu-
pied storage space. The factory-defined pre-
sets that occupy the first five storage spaces
cannot be overwritten.

3) Beneath the list field, click the button SAVE.
While the preset is being saved, the button
SAVE has a red contour. Upon completion,
the preset name entered appears in the list
field.

6.5.3 Saving a preset on the computer
To save a preset on the computer:
1) In the main window (—MAIN), beneath PC

PRESET, click the button SAVE. The dialog
window “Choose a preset file” appears.

Alternatively, call up the dialog window by
means of the menu item “File » Save”.

»

Enter the file name desired, select the stor-
age location and save the file. The file name
suggested by the system is the preset name
preceded by the storage space number; the
file extension “.preset” is automatically added
to the name.

Regardless of the file name, the file will also
save information about the preset name and the
storage space number.

6.5.4 Loading a preset from the computer
To load a preset from the computer:
1) In the main window (—MAIN), beneath PC

PRESET, click the button LOAD. A dialog
window appears.

Alternatively, call up the dialog window by
means of the menu item “File » Open”.

n

The preset saved in the file is loaded onto the
user interface and is shown along with its
name and the storage space number that
was assigned to the preset when saved. The
preset may of course now be saved in a dif-
ferent storage space of the speaker system
storage (1= chapter 6.5.2).

6.5.5 Saving all presets on the computer

To simultaneously save all presets of the
speaker system storage on the computer:

1) Call up the menu item “Hardware »Backup
Presets”. A dialog window appears.

2) In the dialog window, select the folder where
the files are to be saved, and then confirm
your selection.

3) While the presets are being saved, a window
is shown indicating the saving progress.
Upon completion (message “Done”), click the
button [Close] to close the window.

In the selected folder, a new folder named after
the MAC number of the corresponding speaker
system is automatically created. This new folder,
in turn, includes a folder the name of which is
made up of the word “Backup” and the date/time
the folder was saved. This backup folder con-
tains the files with the presets of the speaker
system.

6.5.6 Restoring a set of presets

To restore a set of presets saved on the com-

puter to the storage of the speaker system:

1) Call up the menu item “Hardware » Restore
Presets”. A dialog window appears.
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In the dialog window, select the folder desired
(folder with the MAC number of the appropri-
ate speaker system, then backup folder with
the appropriate save date/time), and then
confirm your selection.

&L

While the presets are being restored, a win-
dow is shown indicating the restoring pro-
gress. Upon completion (message “Done”),
click the button [Close] to close the window.



This restoring process will only overwrite the
storage spaces in the speaker system that were
occupied at the time when the presets were
saved onto the computer.

6.5.7 Restoring factory presets

To save only the factory-defined presets on the
first five storage spaces of the speaker system:

1) Call up the menu item “Hardware » Load Fac-
tory Presets”. A dialog window appears.

2) In the dialog window, open the folder “fac-
tory”, located in the installation folder of the
program.

L

Select the appropriate file, depending on the
model of the speaker system in question
(MegaDSPxx.factory), and then confirm your
selection.

Example: For the speaker system MEGA-DSPO08,
the files “MegaDSPO08.factory” has to be selected.

CAUTION: At the worst, the selection of a

wrong file may damage the speaker system
during operation.

£

While the presets are being saved, a window
is shown indicating the saving progress.
Upon completion (message “Done”), click the
button [Close] to close the window.

6.6 Additional settings

6.6.1 Changing the name

The speaker systems may be named differently
for easier identification. To change the name of
a speaker system:

1) In the main window (—MAIN), in the field
beneath UNIT CONNECTION, overwrite the
current name with the new name, and then
press the Enter key.

The maximum length of the name is 16
characters, and the name may not include
(language-specific) special characters. Oth-
erwise, an error message will be displayed.

2) The name is transferred to the speaker sys-
tem and is shown on the display of the
speaker system. In addition, the name is
updated in the list of speaker systems (figs. 2,
3).

6.6.2 Changing the password
To change the password for the speaker system:

1) Call up the menu item “Hardware » Configure
» Change Password”.

2) In the window displayed, enter the current
password in the field “Enter Old Password:”
(the pre-defined password is “monacor”).
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In the window displayed, enter the new pass-
word in the field “Enter New Password:”.

4) In the window displayed, re-enter the pass-
word in the field “Confirm New Password:”.

Important: Make sure to remember the new
password! If the password gets lost, it will not
be possible to access the settings of the
speaker system via the computer. The setting
options available at the speaker system
depend on the current access right settings
(1= chapter 6.6.6).

The new password is saved in the speaker sys-
tem.

6.6.3 Changing network settings
To change the network settings of the speaker
system:

1) Call up the menu item “Hardware » Configure
» Network Settings” The dialog window “Net-
work Configuration” (fig. 7) appears.
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In the dialog window, select the option “Con-
figure Network Automatically” if the speaker
system is to obtain its network settings from
the DHCP server automatically or (provided
that no DHCP server exists) if the speaker
system is to configure the other network
members. (To be configured by the speaker
system, the other members must be defined
to automatically obtain the IP address).

3) If a specific IP address is to be used, select
the option “Configure Network Manually”.
Enter the IP address in the field “IP-
Address:”, and the subnet mask of the net-
work to be used in the field “Subnet Mask:”.

4) Click [OK] to confirm, or click [Cancel] to keep
the original settings.

M Network Configuration rz|
‘fou can get IP settings assigned automatically by DHCP iF vour network,
supports this capability, or (if na DHCP server is Found) the netwark will
be configured automatically by wour DSP units, Alkernatively, vou can
set a fived IP and subnet mask,

() Configure Metwork Automatically
(%) Configure Metwork Manually:

192.168.1.108
255.255.255.0

1P Address:

Subnet Mask:

@ Network settings

6.6.4 Defining preset for switch-on
To define the settings to be used when the
speaker system is switched on:

1) Call up the menu item “Hardware » Configure
»Power On Preset”. The dialog window
“Choose Preset” (fig. 8) appears.

2) From the list field of the dialog window, select
the preset to be used automatically when the
speaker system is switched on.

If the speaker system is not to use a pre-
set but the settings that were valid when it
was switched off, select the option “Last Set-
ting”.

3) Click [OK] to confirm, or click [Cancel] to keep
the original settings.
I Choose Preset rz|

Choose the preset that will be loaded upon startup of the
unit, Remember, if vou change any setting, this setting will be
wvoid after power cyeling the unit and the original preset will be
loaded again.

|Last Setting w |

[ k. H Cancel ]

Preset at switch-on

6.6.5 Standby mode

If the input of the speaker system does not
receive any signal for a specific period of time,
the speaker system will automatically change to
the standby mode: the display (4) will become
dark, and the LED on the front panel of the
speaker system will change from blue to red. To
define this period of time:

1) Call up the menu item “Hardware » Configure
» Standby Delay”. The dialog window “Unit
Configuration” (fig. 9) appears.

2) Inthe dialog window, enter the period of time
(in minutes) after which the speaker system
is to change automatically to the standby
mode (max. 30 minutes).

With the value 0, the speaker system will
never change to the standby mode.

3) Click [OK] to confirm, or click [Cancel] to keep
the original settings.

The standby mode can also be manually set by
means of the menu item “Hardware »Go to
Standby”.

The speaker system will exit the standby mode
when an input signal with a sufficient level is
present at the input, the button MENU (2) or ESC
(3) is pressed, or the menu item “Hardware # Exit
Standby” is called up in a configuration window.

I Unit Configuration

Set the delay time for the Auta-Standby Function {minutes):

12.0

[ Ok ] [ Cancel ]

@ Standby delay

6.6.6 Options for a locked speaker system
When a speaker system is switched on or when
the network connection is interrupted during
operation, the speaker system is “locked”, pro-
viding only a limited range of operating options.
To define the operating options available for a
locked speaker system:

1) Call up the menu item “Hardware » Configure
» Locked Rights”. The dialog window “Access
Rights” (fig. 10) appears.

2) Select (check mark) the options that are to be
available for a locked speaker system:

Access Input Channel:
Accessing input configuration
Load Presets:

Loading presets

Save Presets:

Saving presets

Change Unit Name:
Changing the unit name

Change Unit Configuration:
Changing general settings (network, standby
mode, preset at switch-on)
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@ 3) Click [OK] to confirm, or click [Cancel] to keep

20

the original settings.

Locked-5tate Access Rights: Enable access fior the end user
AFTER locking the unit {Hardware - Lock Unit or via LCD
display’ by checking the checkbox per Function,

[Jaccess Input Channel
Load Presats

|:| Save Presets

[[] change Unit Mame

[¥] Change Unit Configuration (etwark, Autostandby, Startup Preset etc)

Locking options

6.6.7 System information

Call up the menu item “Help » About” to view
information about the speaker system and the
network connection as well as about the ver-
sions of the speaker system firmware, the inter-
face firmware and the computer program (fig.
11). If a newer firmware version is available in
the computer program, the user will be informed
accordingly (Update Available); in this case, the

7 Specifications

firmware should be updated (1=° chapter 6.3.4).
For up-to-date firmware or interface firmware,
(OK) is shown behind the respective version
numbers.

M Ahout §|

Unit InFarmation:
Marme: mega-dsp 10
Serial Mumber: 39976
Connected By: 192.168,1,108
MAC Address: B 967400005 7C
Firmnware Yersion: 3.1.6 (OK)
Interface Yersion: 2,7.0 {0K)

Application Information;
Application Version: 3.1.6
Build: 103669

Copyright () Monacor

@ System information

Use the menu item “Hardware # Status Detail” to
view the errors that may have occurred.

6.6.8 Closing the configuration window
Call up the menu item “File # Quit” to exit the win-
dows for configuring a speaker system. As long
as the speaker system is not switched off or not
disconnected from the network, the user does
not have to re-enter the password when calling
up the speaker system again by means of the
button [>>] in the list (figs. 2, 3).

To enforce a re-entry of the password, call
up the menu item “Hardware #Lock Unit“. A
message is shown informing you that the correct
password will then be required to access the set-
tings of the speaker system.

Model MEGA-DSP08 MEGA-DSP10 MEGA-DSP12 MEGA-DSP15
Amplifier power (rms power)

Treble 100 W

Bass 500 W
Frequency range (-6 dB) 60—-20000 Hz 55—-20000 Hz 45-20000 Hz 40-20000 Hz
Max. SPL 116dB 119dB 121dB 123dB
Bass speaker @ 20cm (8”) @ 25cm (10”) @30cm (12") & 38cm (15”)
Tweeterr dynamic horn tweeter, & 25.4mm (1”)

Voice coil & 44mm
Rated input voltage

LINE 1V

AUX 1V

MIC 50mV
Max. input voltage

LINE 7V

AUX 5V

MIC 850 mV
Input impedance

LINE 16 kQ

AUX 8kQ

MIC 2kQ
Directivity -6 dB (H x V) 90° x 60°
Ambient temperature 0-40°C
Power supply 230 V~/50 Hz 230 V~/50 Hz 230V~/50Hz 230 V~/50 Hz
max. power consumption 320 VA 360 VA 580 VA 790 VA
Dimensions (W x H x D) 290 x 480 x 313 mm 320 x 504 x 345 mm 350 x 612 x 383 mm 416 x 678 x 454 mm
Weight 15.5kg 18kg 19kg 25.5kg

All rights reserved by MONACOR® INTERNATIONAL GmbH & Co. KG. No part of this instruction
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Subject to technical modification.
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